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IMPORTANT: This guide is a general Getting Started manual for all 

FL Studio Editions (Express, Fruity & Producer). Some features are not 

available all editions. E.g. Express Edition does not have access to the 

Playlist & Express/Fruity Editions do not have Audio or Automation 

Clips. Please check our site http://flstudio.image-line.com  for upgrade 

options. 
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WWWWWWWWEEEEEEEELLLLLLLLCCCCCCCCOOOOOOOOMMMMMMMMEEEEEEEE        TTTTTTTTOOOOOOOO        FFFFFFFFLLLLLLLL        SSSSSSSSTTTTTTTTUUUUUUUUDDDDDDDDIIIIIIIIOOOOOOOO        
 
This guide is a general introduction to using FL Studio. Please press F1 while you are running the 
program to open the in-line manual for detailed help on specific features or functions.   
 
Lifetime FREE updates of the edition you own: Did you know that customers who bought FL 
Studio 2 (way back in 1999) have received FL Studio 3, 4, 5, 6, 7, 8 and 9 absolutely free! That’s 
about $1500 of free updates. If you have the Boxed version, register online to get your Lifetime 
Free Updates. If you bought FL Studio via Internet download, you are already registered for 
Lifetime Free Updates.  

So how has Image-Line stayed in business for over 13 years? You will notice that we include a 
number of demo plugins in the program and we rely on happy customers purchasing these 
(Maximus, Poizone, Sawer, Sytrus, Toxic Bio, Vocodex etc) and loop/sample content. Our 
philosophy is that you should pay only for what you use, and never pay for bug-fixes (hello 
competitors?!). Visit http://www.image-line.com to see what we have on offer.    

Here are just a few of the cool features in FL Studio: 

- Recording: Audio (microphones, guitars, synths), automation (knob / mouse movements) 
and notes (polyphonic melodies) live, then edit the performance. 

- Easy hardware controller linking: Right-click on the FL interface control, select link and 
tweak the hardware controller knob, done.  

- Piano Roll: The most advanced piano-roll in the industry. Per-note slides for native FL 
Studio plugins. Complete suite of editing and creative composition tools. 

- Step sequencer: Fast and intuitive pattern-based sequencing, perfect for percussion.  

- Edison wave editor/recorder: Record, analyze, edit and transform audio. With beat 
slicing. 

- Share: import/export .wav (wave), .mp3 (mpeg layer 3), .ogg (Ogg Vorbis), .mid (MIDI) 
files and more. 

- Fast: Of course there is the legendary FL Studio workflow, the fastest path from your 
brain to your speakers! 

 
 
 
 
 
 
 

Lemon Boy is in the house: Hey Dudes!  Having problems? Before you 
panic and start spamming the FL Studio Tech Support, look for me.  I'll pop 
up here and there with answers to common problems that might save you 
some trouble. Of course, don’t neglect to press F1 inside FL Studio to open 
the in-line help or visit the on-line forums http://forum.image-line.com/ .  
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IIIIIIIINNNNNNNNSSSSSSSSTTTTTTTTAAAAAAAALLLLLLLLLLLLLLLLAAAAAAAATTTTTTTTIIIIIIIIOOOOOOOONNNNNNNN        IIIIIIIINNNNNNNNSSSSSSSSTTTTTTTTRRRRRRRRUUUUUUUUCCCCCCCCTTTTTTTTIIIIIIIIOOOOOOOONNNNNNNNSSSSSSSS        
 

The installation procedure for FL Studio differs slightly, depending on whether you purchased the 
product online, or as a boxed version with a CD and this manual. Read below for what to do: 
 

A. If you purchased FL Studio as a boxed version, follow these steps:    
 

1. Run the CD. Insert the install CD-ROM that comes with your box in your CD-ROM 
drive. If you have auto-run enabled, you will see the CD menu automatically appear. 
Otherwise, right-click your CD-ROM drive icon in Windows Explorer and select 
Autorun. 

2. Start the Installation. Select the FL Studio installation link. The installation window 
will appear. Follow the instructions on screen. Check the 'Extra Sample' option if you 
want to install the additional Generic Sample CD samples. 

3. Registration code. During the installation you will be asked to enter a serial number. 
Write it down for future use and to make a backup of this number. 

4. Register On-line. After installation you can register online to gain access to Lifetime 
FREE Updates, the extra FL Studio website features and community. Go back to the 
CD-ROM menu (reload as described in step 1 if needed), and click on the link called 
“Click here to register to the FL Studio community” or go to this link  
http://boxregistration.image-line.com. NOTE: This is insurance against lost CDs! 
You can also get the latest version of FL Studio (as shown below). 

 
B. If you purchased FL Studio online, as a download version, follow these steps:    
 

1. Download and Install the Demo. Download and install the demo version of FL 
Studio. It is recommended NOT to install over previous releases of FL Studio or 
Fruityloops. The Demo is at http://www.image-line.com/downloads/downloads.html 

2. Download a Regcode. Go to http://my.image-line.com and enter your username and 
password you received by e-mail after your purchase. Your regcode can be 
downloaded from the ‘My Licenses’ section to the right. Click on a product link to 
open it and click ‘Click here to unlock this product’. Save the FLRegkey.Reg to disk. 

3. Install the FLRegkey.Reg file. Double-click the file or right-click and select 
‘Merge’. Allow the file to be written to the Windows registry. 

Problems? See our searchable Knowledge Base – http://support.image-line.com/knowledgebase 
and support forums http://forum.image-line.com. In case of order or registration related support, 
please create a support ticket at our website http://support.image-line.com.  
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FFFFFFFFIIIIIIIIRRRRRRRRSSSSSSSSTTTTTTTT        RRRRRRRRUUUUUUUUNNNNNNNN        
OK, so you just finished the installation and started FL Studio. This section explains what you 
will see. As soon as you start FL Studio, you may be confronted with strange dialog boxes and 
messages. Don’t forget to check the extensive on-line help that comes with FL Studio (press F1) 
and check our ‘Getting Started’ video tutorials: 

www.youtube.com/view_play_list?p=A988BD357AA510D1 

 
1. The System Settings Screen. When you first run FL Studio, you should press F10 on your 

PC keyboard to access it. Use the select boxes to choose your sound card and hardware 
controllers. At first, you may be looking at the MIDI screen, but for now the most important 
one is the Audio screen, accessed as shown below. 

 

  
 
 

2. Select a Soundcard Driver  from the list in the pull-down menu. Select an ASIO driver if 
possible (identified by the word 'ASIO' in the name), as they allow lower buffer lengths (see 
below) with less CPU load compared to DirectSound drivers. If your soundcard does not 
'natively' support ASIO, the ASIO4ALL generic ASIO driver http://asio4all.com should work 
for you. If you don't know which one to pick, just leave it as it is. If you experience sound 
problems later on, you can come back to this screen (by pressing F10) and experiment with 
other options. 

1. Click Here 2. Then Here 
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3. Buffer Length.  You don’t need to worry about most of the settings here yet but you 
definitely should know what the Buffer Length does. The Audio Buffer is a temporary store 
of audio data waiting to be sent to the soundcard. This allows FL Studio to even out 
momentary spikes in processing load. If the Audio Buffer runs dry, because your PC can't 
keep up, then your soundcard will make rude pop, click or glitch noises (a buffer underrun). 
It’s worth noting that underruns can ONLY occur in real-time playback, they will not happen 
in  exported audio files.  

Making the buffer longer will reduce underruns but FL Studio may feel sluggish when 
working live. Use trial-and-error to find a buffer length that is short enough so FL Studio 
feels responsive but not so short that causes underruns. We’ve found ~10 ms (440 samples) is 
the point of diminishing returns where CPU load ramps up steeply with no improvement in 
‘feel’. Experiment with 10-30 ms. For a standard DirectSound driver, the ‘Use Polling’ and 
‘Use hardware buffer’ options may improve latencies for some operating systems (2 
switches x 2 states = 4 combinations, try them all), expect buffer settings of 20-40 ms.  

 

The term 'Soundcard' is used very loosely, you may have a separate 
soundcard in your PC, a chip on your motherboard or it may be an 
external device connected by USB/FireWire etc. The soundcard is any 
device that makes the sound you hear from your PC speakers. The 
Soundcard Driver is the software interface between the Windows 
operating system and the soundcard. The driver tells FL Studio what 
inputs/outputs the soundcard has and what sample-rates it can support. 
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4. The Main Screen.  After you’ve closed the System Settings window, you'll be looking at a 
screen similar to the one below (the windows will probably be in different locations). The FL 
Studio desktop is based on a number of windows, most of these are movable (with overlap), 
resizable, zoomable and switchable so if a window isn't visible retrieve it using the Shortcut 
toolbar (or the function keys as noted in brackets below). The three main windows involved in FL 
Studio music creation are - Channels (F6), the Mixer (F9) and the Playlist (F5).  

 

 

Video Tutorials! A picture is worth 1000 words, so a video must 
be worth, like, BILLIONS;once you are registered pop over to the 
FL website and watch hours of cool video tutorials, this is really 
useful so I’ll SHOUT –  

http://www.youtube.com/user/imageline 



 

 10 

MMMMMMMMAAAAAAAAKKKKKKKKEEEEEEEE        SSSSSSSSOOOOOOOOMMMMMMMMEEEEEEEE        NNNNNNNNOOOOOOOOIIIIIIIISSSSSSSSEEEEEEEE        
 

Press the Play Button (also make sure the switch to the left is in 

SONG mode).  You'll hear the demo song. If this is not the first time 
you've run FL Studio, you'll have to reload this demo. Open the browser 

(F8) left-click on the ‘Projects’ folder and right-click on the  NewStuff.flp, then select ‘Open’ 
from the menu. You can also drag the FLP file onto the desktop to open it. FLP files are FL 
Studio Project files and save entire songs.   

HHHHHHHHEEEEEEEELLLLLLLLPPPPPPPP!!!!!!!!        
 

This guide is intended to get you up and running - it is not meant to be a reference manual for 
everything FL Studio can do (that’s what the internal Help system, press the  F1 key on your PC 
keyboard, and the FL Studio Bible are for). Let’s consider the main FL Studio components, in 
brief -  
 
1. The Hint Bar. This is located on the Main Window just under the Menu Bar (top left in the 

picture on the previous page).  When you hover your mouse over any of the controls in FL 
Studio, this panel will display a short description of what that control does and when you 
move a control, it’s value. The Hint Bar also shows you the Shortcut Key that will activate 
the same function.  This is displayed on the right. Pressing this shortcut key has the same 
effect as pressing the corresponding button. 

 

 
 

2. On-line Help.  FL Studio also comes with an extensive on-line help reference. Just use the 
Help Menu and select Contents. This help also features context-sensitivity – select a 
window and press F1 on your keyboard. The reference automatically displays the help you 
are looking for. You will notice three tabs CONTENTS (the help), INDEX and SEARCH. 
The latter two tabs can be searched for key-words, try it! 

 
3. Tutorial Loops.  Click File >Open and surf to the Tutorials directory.  These loops contain 

notes on how to do various things in FL Studio. 
 
4. The Website.  FL Studio has a massive web site at http://flstudio.image-line.com.  The site 

has a support section that includes a FAQ Knowledge Base, User Forums, Online 
Tutorials, Video Tutorials, Song Exchange and more.  Check the discussion forums to see 
if your questions have already been answered, or log in and post your own. 

Hint Bar 
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GGGGGGGGEEEEEEEETTTTTTTTTTTTTTTTIIIIIIIINNNNNNNNGGGGGGGG        SSSSSSSSTTTTTTTTAAAAAAAARRRRRRRRTTTTTTTTEEEEEEEEDDDDDDDD        
 

The following section will guide you through some of the basic (and not so basic) features you 
will use to make music with FL studio. You should however spend some time with the in-line 
help file (press F1 inside FL Studio) and at least work through the Setup Wizard and 
Introduction to FL Studio sections. 
 
 
 
 
 
 
 
 
 
 
 

TTTTTTTTHHHHHHHHEEEEEEEE        CCCCCCCCHHHHHHHHAAAAAAAANNNNNNNNNNNNNNNNEEEEEEEELLLLLLLL        WWWWWWWWIIIIIIIINNNNNNNNDDDDDDDDOOOOOOOOWWWWWWWW        &&&&&&&&        SSSSSSSSTTTTTTTTEEEEEEEEPPPPPPPP        SSSSSSSSEEEEEEEEQQQQQQQQUUUUUUUUEEEEEEEENNNNNNNNCCCCCCCCEEEEEEEERRRRRRRR        
 

When you start FL Studio for the first time, you'll see the Channel window (see the “First Run” 
section). Channels are instruments that can send audio to any Mixer Track (set with the Channel 
settings Mixer track selector). When you left-click on a Channel button this will open the 
Channel Settings (and plugin interface if it has one, Sytrus for example) or right-click a Channel 
button to select the Piano Roll. The Channel Window also contains the Step Sequencer, with a 
default grid pattern ideal for creating beats by triggering percussion samples loaded in Channel 
Samplers. The Piano Roll (page Error! Bookmark not defined.) is better suited to more 
complex compositions. 
 

 

HEY! Don't skip that step.  This guide 
will work a lot better if you start at one 
end and work your way through to the 
other. 

Plugin interface 

Channel settings 

Mixer track 
Channel 
buttons 
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1. What are Channels for? Channels are laid out horizontally (see below) and each one 

contains a single instrument or sound. Each Channel step sequencer has, by default, 16 steps.  
If you're musically inclined, these steps represent 16th notes.  If not, think of each group of 
four steps as one beat, so 16 steps are the four beats of a basic 4x4 drum loop. 

 

  
 

2. What Steps are For?  Click a step to activate it, this tells FL Studio to trigger the instrument 
loaded into that Channel at that point in the bar or loop.  For instance, the 1st, 5th, 9th, and 13th 
steps in the 1st Kick Channel are selected, telling FL Studio to play the kick drum sound four 
times during the loop (if you are thinking of groups of four steps as a single beat, FL Studio 
will play the sound at the start of each beat.)  Try changing the pattern of steps in the 
DNC_Kick Channel. (If you need to turn a step off, right-click it.)  Once you've got the steps 
to light up like the picture below, press the play switch to hear what you've created. 

 

 
 

 

Channel 
Mute, Pan 
& Vol 
Controls 

Steps, on 
and off 

A Channel 

Channel 
Name on 
button 

Suggested 
Pattern 

Change number of 
Steps here 

When programming patterns use PAT 
mode. FL Studio will then play the 
selected pattern. 
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3. How do you use patterns? While it’s cool to make a bunch of patterns, it’s not particularly 
useful to play a single loop over and over (unless you are jamming on a guitar or something). 
The key is to place these patterns in the Playlist (more on that later). All the note data 

contained in the stack of instrument Channels 
in the Channel Window is known as a 
'pattern'. You can switch to a new pattern with 
the Transport Panel 'PAT' selector. When you 

do this, the note data visible in the current Pattern will change to reflect the selected pattern. 
To hear only that pattern (rather than the whole Playlist) make sure the button at the front of 
the Transport Panel is in ‘PAT’ mode. Once you have made a bunch of Patterns, you can 
select the pattern using the PAT selector (or the Playlist Clip selector), then left click on a 
blank area of the Playlist (in pencil mode) to place it in the Playlist as Pattern Clip (upper 
area) or Pattern block (lower area). 

 
4. Play with the Channel Controls. After you've set up the pattern, try playing with the 

Channel Controls on the left.  The two round knobs control the volume and pan of a single 
Channel, and the green light switches the Channel on and off. Panning is similar to  the 
balance control on a stereo; turning this knob moves the sound from left to right in the stereo 
field. To reset a knob to its default position, right-click on it and select reset. 

 
5. Make Your Own Beat. Don't like the beat above?  Good, then its time to make your own 

beat! In the next sections, we'll teach you how to load in new samples, set up melodies, and 
change the sound of each Channel (and even each step) using Plugin Effects. 

 
 
 

         
More about the Playlist on page 29. 

 

Pencil or 
brush mode 

Select pattern 
to place here 
using the 
‘Clip selector’ 

Left-click on the blank areas 
to add the selected pattern 

Play here 
Learn what 
‘Snap’ does 
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TTTTTTTTWWWWWWWWEEEEEEEEAAAAAAAAKKKKKKKKIIIIIIIINNNNNNNNGGGGGGGG        TTTTTTTTHHHHHHHHEEEEEEEE        CCCCCCCCHHHHHHHHAAAAAAAANNNNNNNNNNNNNNNNEEEEEEEELLLLLLLLSSSSSSSS        
 

In this section, we'll show you how to modify the sound of the samples in each sampler Channel. 
FL Studio supports so much of this kind of tweaking that it's possible for two people to create 
loops that sound totally different using exactly the same samples (technically, each Channel 
contains a Instrument, which could be a sample or a synthesizer plugin). While there are 
dedicated samplers like FPC (percussion) & DirectWave (instruments), the single Channel 
sampler is a versatile and useful tool.  

 

 
 
 
 
 

1. Load a New Sample. Check out the Browser.  One way to load samples is to use the 
Browser (that's the other window you see when you first opened FL Studio in the "First Run" 
section above.) This is a special browser for selecting and loading samples, loops and presets 
files.  To find a Kick sound, click on Packs, and then Dance. Left-clicking on a sample in the 
list will play it, right clicking will open it into the selected Channel. You can also drag and 
drop into the Step Sequencer.  Select a Channel by clicking on the green Channel Selector 
light to the right of the Channel name as shown above. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Wait! What's a "sample"? A sample is a recorded sound 
stored in a file.  Each Channel in FL Studio, by default, uses a 
single sample, usually containing a single note (like a snare 
drum hit or a single bass note), but they can also contain 
entire beats (loops) or tunes.  Samples are usually ".wav" files 
but FL Studio supports ".mp3" and “.ogg” sound files too. 

Lost the Browser? No problem.  The five 
big buttons on the tool bar shown below 
will open and close various windows for 
you, including the Browser & Step 
Sequencer.  (The will become clear in the 
fullness of time;) 
 

 

Click Here 

Then Here 

Then Here 

Open 
Browser 
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2. Open the Channel Settings Window (left-click on a Channel button).  OK, let's modify 
the kick drum sample.  Load a Kick sound (shown below) and open the Channel Settings 
window for that Channel by left-clicking on the name button. You can also change samples 
using the Open file icon to the left of the Sample Name window (as shown below) -  this will 
open a browser on the directory containing kick drum samples. As you click on them, FL 
Studio will automatically play the sounds. Try opening some of the other samples and 
listening to the effect a new kick drum has on the sound of the loop. 

 
 

 
  

 
 

Click 
Here 

Sample 
File Name Channel 

Selector 

Open file 

Save!  If you’ve created a masterpiece 
and you want to keep it, don’t forget to 
save. There’s a cool ‘Save new 
version’ that will add a 1,2,3;etc on 
the end of the FLP name, so you can 
keep all your old versions.  
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3. Play with the Sampler Channel Effects. It’s worth noting that FL Studio can add audio 
effects on Mixer tracks (set by the FX selector), but this section is to show you the power of 
Channel sampler effects. Ok, at this point the best advice is to start the pattern looping, then 
play with the controls in the sample (SMP) panel of the Channel Settings Dialog and listen to 
the difference in sound.  Here's a short description of what some of them do. For more info 
see the on-line help.  

 
 
 
 
  
 
 

 

Can't hear the difference?  If you press a button or turn a knob 
and you can't hear any difference in the sound, try making the 
same change on another Channel.  For example, sometimes a 
change that doesn't affect a kick drum much will make a huge 
difference to the sound of a snare.  If you still can't hear the 
difference, stop the loop from playing and listen the sounds 
separately by clicking on the wave view window.  You might be 
able to hear the effect better without the other instruments. 

Vol, Pan: Volume and panning 
wheels that also appear on the 
main screen for each Channel.  
Turning these will also makes 
the knobs on the Channel 
Window move to match. 
 

Remove DC Offset: Use this 
option to fix “vertical” offset in 
the samples (see Wave View 
below). 
Reverse Polarity: "Flips" the 
waveform vertically.  
Normalize: Maximizes the 
sample volume without 
distortion.  
Fade Stereo: Creates a stereo 
fade from the left to the right 
Channel of the sample.  
Reverse: Reverses the 
sample.  
Swap Stereo: Switches left 
and right Channel of the 
sample. 

Wave View Window: 
Shows the shape of the 
sound sample. Click here to 
hear the sample with all the 
effects. Also a drag and 
drop window for loading 
samples. Right-click too! 

 

Fade In (IN): Applies a quick 
fade in to the sample (turn 
maximum to left to disable).  
Fade Out (OUT): Applies a 
quick fade out to the sample 
(turn maximum to left to 
disable).  
Pitch bend (POGO): Applies 
pitch bend to the sample. Useful 
with drum samples.  
Crossfade Loop (CRF): Allows 
you to crossfade the sample for 
the creation of smooth loop 
sections (turn maximum to left to 
disable).  
Trim Threshold (TRIM): FL 
Studio trims the silence at the 
end of the samples, as this frees 
up RAM and does not alter the 
resulting sound. This control 
allows you to raise the volume 
threshold below which FL Studio 
detects "silence". 
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4. Add Some Echo.  Open a_Kick Channel settings and click the FUNC tab to get the view 
shown below.  The controls in the top section (Echo delay / fat mode) can be used to set up a 
cool echo effect for a single instrument.  Start by turning up the FEED about a quarter of the 
way, and listen to what happens to the kick drum sound…  Try playing with the other 
controls to change the sound of the echo… You can also toggle between various echo and 
“fat” modes by clicking the title bar of the Echo Delay section (the default is Classic Echo). 
More on these different effects can be found in the on-line manual. Note: You can also 
achieve the same result with an Audio Effect loaded in the Mixer. More on that later. 

  
 
         
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Pan, Cut, and Res do the 
same job as on the sample 
panel, but the effects build up 
as the echo dies out.   
 
Pitch controls the pitch of the 
echo.  If you turn this knob right, 
the echo will get higher as it 
dies out. 

Feed: Echo volume 
(sets how quickly 
the echo dies out).  

Time: Controls the amount of 
time (in dots) between each 
echo.  Maximum delay time is 
16 steps. 

Ping Pong: Makes 
the echo flip back 
and forth from left to 
right (sounds cool 
on headphones).   

Ech: Number of times the 
instrument will echo before it 
stops. 

Getting Echo Time Just Right: The "Time" control is 
fine-grained to get you just the exact echo you want.  
But if you want to echo on the beat, you will have to 
look at the Hint Bar while you turn the dial. If you want 
the echo every three dots, just turn the dial until the 
hint bar shows "3:00".  

Arpeggiator: This 
gets explained in 
the Generators 
section of this 
guide. 
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5. Play With the Instrument Settings.  Let's take a quick look at the INS panel before we 
move on (There's also stuff you should read about in the MISC, check the FL Help).  Click 
on the INS tab and you'll get to the Instrument Settings.  Here you can add Envelopes and 
LFO to your sample for the Volume, Pan, Cutoff, Resonance, and Pitch settings.  

 
 

 
 

 

6. What's an Envelope? An envelope causes a parameter to vary over the life of the sound. 
One of the most common is a Volume Envelope, that makes the sound rise then fall in 
volume. You can also set an envelope to affect Pitch, Cutoff, and Resonance.  In terms of a 
volume envelope (VOL), the Delay (DEL) sets how much time passes before the envelope 
starts, Attack (ATT) is the fade-in speed, Hold (HOLD) sets how long the sound holds at full 
volume, and Decay (DEC), Sustain (SUS), and Release (REL) control how the sound fades 
away.  Play with the knobs and watch the graph change below them. 

7. What's LFO? LFO stands for Low Frequency Oscillatior. It’s like an Envelope but repeats 
a waveform pattern over and over while a note is playing. Most commonly they are used to 
make pitch oscillate up and down over the duration of the sound (vibrato).  The Amount 
(AMT) sets how much the effect oscillates, Speed (SPD) sets how quickly it oscillates, Delay 
(DEL) sets how much time passes before the oscillation starts, and Attack (ATT) sets how 
quickly the oscillation ramps up to it's full amount.  Play with the knobs and watch the graph 
change. 

Effect Selector 

Envelope 

LFO 

Right-click along this 
bar to set the natural 
(root) note 

Select this switch to 
activate the envelope 
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8. How do I Use Them? Use the Effect Selector (see diagram above) to choose the effect, and 
then turn the knobs on either the Envelope or the LFO.  To turn the Envelope on and off for 
each effect, click on the Indicator Light.  To turn off the LFO, reset the Amount (AMT) to the 
middle (knob pointing straight up.) 

9. Why Can't I Hear the Effect?  If you're still on the Kick Drum it will be hard to hear any 
LFO effect, although the Envelope might make a difference.  These effects are more audible 
on longer samples or on sustained instrument sounds such as 3OSC.   

 

 

 

 

 

 

 

 

 

 

 

 

When you left-click on a Channel button, the Channel 
settings will open along with the plugin interface. You will 
find that some of the Channel settings controls may not 
have any effect on the sound, this is normal. Generally for 
plugin instruments the Channel settings FX selector is 
used to send the audio to a Mixer track.  One tab on the 
Channel settings that is cool with Plugin Instruments 
however is the FUNC (Function) tab. Experiment with the 
Arpeggiator, great for playing live with a MIDI keyboard. 
 
Now we're cookin' with gas! Kor is your PC on fire? 
 

Signal flow from Channels to the Mixer 
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TTTTTTTTWWWWWWWWEEEEEEEEAAAAAAAAKKKKKKKKIIIIIIIINNNNNNNNGGGGGGGG        NNNNNNNNOOOOOOOOTTTTTTTTEEEEEEEE        PPPPPPPPRRRRRRRROOOOOOOOPPPPPPPPEEEEEEEERRRRRRRRTTTTTTTTIIIIIIIIEEEEEEEESSSSSSSS        
 

By now you're familiar with some of the ways FL Studio lets you tweak and shape Sampler 
Channel sounds.  In this section, we'll show you how some of those effects can be applied to each 
step separately.  We'll also show you how to program melodies. Note that if you have Fruity 
Edition or higher then we strongly recommend that you use the Piano Roll instead of the step 
sequencer for melodic work (see page Error! Bookmark not defined.). 
 
1. The Levels Editor.  The easiest thing to understand here is probably the Graph Editor 

utility. First, select a Channel to edit by clicking on the Channel name, or by clicking on the 
green Channel Selector light to the right of the Channel name. Next, press the graph editor 
button that pops up the editor as shown below.   

 

2. Effect Selector.  Try clicking and dragging the Target Selector under the graph to see what 
effects can be graph-edited. You will see Pan, Velocity (another name for Volume),  Filter 
cut, Filter res, Pitch, and Shift. Though some of these effects were discussed in the 
"Tweaking the Channels" section, the difference here is that you can also tweak the value of 
these effects for each step separately. Each bar on the graph sets the effect value for the single 
note above (or below) it.  

Levels editor 
Button 

Graph Editor 

Target 
Selector 

Channel 
Selector 
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3. Panning the Kick Drum.  Try setting the pan effect as shown below.  The pan graph centers 
in the middle.  You can set pan values by clicking inside the bar for each note at the desired 
level.  After you have set up the view shown below, you should hear the kick drum flipping 
back and forth from one speaker to the other.  This sounds really cool if you combine it with 
the 3-step echo you added in the previous section… 

 

 
 

4. Try the Velocity. You can fade in and out over a pattern using the velocity graph. Try filling 
in all the steps, opening the Graph Editor on Velocity then make some variations like those 
shown below (left-click and drag up/down on the bars). When you press play (in pattern 
mode) you will hear the volume ramping with each step. This graph does not center in the 
middle like pan, but goes from zero (bottom) to maximum (top). Volume slides like this can 
sound extra cool when combined with Cutoff and Resonance slides. Hint: to make a smooth 
line in the graph editor, right-click on the first bar, then drag the mouse to the right to set the 
values of all the bars at once. 
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5. Play with the Other Effects.  Try to get a feel for the other effects on the graph editor.  
Filter Cut and Filter Res can be used to add or subtract values to the main cutoff and 
Resonance knobs in the INS panel of the Channel settings dialog box. (See the "Tweaking the 
Channels" section.) Pitch makes the sample higher or lower, like the pitch knob in the 
Channel settings dialog box. Shift can be used to push a step closer to the step beside it (you 
more musical types can use this to groove a beat). 

 
6. Make melodies. Generally the Piano Roll (page 23) is the best place for composing melodies 

(right-click on a Channel button), however if you have a melodic instrument loaded (such as 
the ‘3OSC’ instrument) the Keyboard Editor can also be used. To load ‘3OSC’, right-click 
on an instrument button and use the ‘replace’ command from the popup menu. To edit notes 
in the melody, click the Keyboard Editor button with the 3OSC Channel selected as shown 
below. What you see now is a vertical piano keyboard for each step on the screen.  Hopefully, 
you have some keyboard skills. (If not, it's time for some lessons!) You can change each note 
by left-clicking one of the buttons on the keyboard. Right-click turns the note off. When the 
loop is not playing, clicking a note will also play that note. But again, the Piano-roll is better 
for serious melodic work. 

 

 
 
 

 
 

Keyboard 
Editor switch 

Keyboard 
Editor 

Channel 
Selector 

Note slide  
switch 

Left-click to add notes, click and drag to 
move, right-click to delete. 
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Super Important Tip. When you want to make a melody from longer samples, you often need to 
set it up so that each note cuts off the previous one. This easiest way to do this is by right-
clicking the Channel Name in the Step Sequencer and selecting Cut Itself from the popup menu.   
 
 
 

 

Big News!  You can undo the last tweak 
from the Edit Menu or with CTRL Z. There is 
also an ‘undo history’ in the Browser 
directory called ‘Current project, History 
folder. Click up and down the list to un/re-do 
changes. Make sure F10 > General 
Settings > Undo knob tweaks is selected. 
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TTTTTTTTHHHHHHHHEEEEEEEE        PPPPPPPPIIIIIIIIAAAAAAAANNNNNNNNOOOOOOOO        RRRRRRRROOOOOOOOLLLLLLLLLLLLLLLL        ((((((((NNNNNNNNooooooootttttttteeeeeeeessssssss))))))))                
  

You  have probably already realized that there are some things that the Step Sequencer doesn't do 
very well.  It gets tricky to use when you have melodies that are longer than 1 bar.  It's also tricky 
if you want to play chords. The Piano Roll solves all of these problems! 
 
1. Open the Piano Roll.  Load up NewStuff.flp and select a pattern that shows some green bars 

as shown below.  Notice that the Step Sequencer view is very different.  These Channels 
contain Piano Roll data instead of normal steps.  You can open the Piano Roll for any, 
Channel either by right-clicking the Channel name or by left-clicking the Mini Piano 
Roll.  Open it for the Ins_Round Channel. 

 

  
 

2. What You're Looking At.  First thing to notice is that this screen looks a little like the Event 
Editor.  See the Play Indicator Bar, the Edit Mode Buttons, and the Edit Menu Button?  
But the "events" in the Piano Roll are notes to be played at the given location, rather than 
level settings for various FL Studio controls.  Each horizontal green line shows where a note 
should start and end, and the Piano Keyboard on the left shows the pitch of each note.  The 
note labeled below is a C5 (C in the 5th octave), which will start on the second beat of the first 
bar and play for 3/4 of a beat.  

Left Click Here 
(Mini Piano Roll) 

Right Click Here 
(Channel Name) 
 
Then Here 
 

Watch where you click! The mini view Piano roll in the 
Channel window has a cool feature, that for long Piano roll 
scores it will open the Piano roll at the location where you 
clicked. Super duper! 
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3. What’s with the lower Piano roll window? . This allows you to adjust all sorts of note 
parameters such as note velocity, pan and also Channel automation. If there is any Event 
automation in the pattern that the Piano roll is part of, you can select that too and edit it in the 
lower window, just like in the Event editor. Even more lazy? You can use the Channel 
selector to change Piano rolls within the pattern (Noted as “Change Channel here’ above). 

 
4. What Kinds of Channels Can Have Piano Rolls?  You can have a Piano Roll for any type 

of Instrument.  But there's something you should know about Sample Channels.  You can 
use the Piano Roll on any Sample Channel, great for percussion programming, but chords and 
sustained notes will always work best when you are using Looped Samples.  Loop points 
that let the sample play over and over again to create a sustained sound that lasts as long as 
the note is held (length of the green bars above).  If you don't have a looped sample, you can 
still use the Piano Roll, but remember your notes may not last as long as you wanted them to. 

Edit Menu Edit Mode  
Buttons 

Play 
Indicator 

Note 
C5  

Vertical 
Zoom 

Keys 
Mode 

Local 
Snap 

Velocity(volume) 

Change 
lower PR 
data type 
here 

Change 
Channel 
here 

Drag here for Horizontal Zoom Drag here for Horizontal 
Position 
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5. Basic Piano Roll Editing -    
 

a. Entering Notes. To enter a note, make sure you're in Draw Mode by clicking the Draw 

Mode Button ( )or the Paint Mode Button ( ), click on the note area, where you 

want it to start then release. Next grab the middle of the note and drag it up/down. If the 
project is not playing, you should hear the note you are entering as you drag it around. 
The length of the note will match the length of the last note you placed.  To change the 
length, grab the right hand side of the green bar and drag it.   

 

b. Note Snap.  You may find the note snaps to a place you didn't want it to go.  If so, 
change the Snap Level on the toolbar the same way as you did for the Event Editor (see 
previous section).  Sometimes you just can't get the note length to snap where you want 
no matter what you do.  In this case, hold the ALT key to override snap and drag the note 
(smooth!).  

 

c. Note Color. See the row of 4 colored buttons under the Edit Mode Buttons?  These let 
you select the color of the notes you enter.  This may seem odd right now, but color-

Using Loop 
Points 

Loop 
Points 

Man, this thing 
just keeps 
gettin' better! 
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coding can really help you out when you're trying to make sense of the notes you entered.  
Plus, the Edit Menu lets you Select By Color so you can Delete or Copy and Paste only 
those notes. Better still, note colors allow you to control different MIDI Channels (see the 
main help in FL Studio, press F1). 

d. Deleting Notes.  Two options here - either right click the note you want to delete or go 
into Delete mode with the Delete Mode Button (see the Event Editor Section). 

 
e. Undoing Changes. Like the Event Editor, there is a limited undo available from the Edit 

Menu or by pressing Ctrl-Z. 
 

f. Cutting, Copying and Pasting Notes.  Go into Select Mode with the Select Mode 
Button (see Event Editor section) and click and drag to highlight some notes.  Then use 
the Cut, Copy and Paste options in the Edit Menu or use Ctrl-C, Ctrl-X, and Ctrl-V.  
Pasting can get a little tricky, though.  The notes will paste to their identical locations in 
the first bar that is currently displayed on the screen.  So to paste from bar 1 to bar 2, 
select the notes in bar 1 and hit Ctrl-C to copy, then scroll over to bar 2 and hit Ctrl-V.  
If the notes don't appear, they probably went into bar 1.  Press Ctrl-Z to undo and try 
again. 

 
6. Chords and Harmonies.  One of the really nice features of the Piano Roll is that you can 

have notes sound on top of each other to create chords and harmonies.  Here, we're getting 
into sophisticated stuff that you need some kind of musical intuition for, but FL Studio does 
make life a little easier by giving you a Chord option on the Edit Menu.  Select the type of 
chord you want, and then go into Draw Mode.  You can now drop entire chords onto the 
Piano roll.   

 
 

 

7. Pitch-Bending Notes.  This is really cool, but only works for FL Studio native plugins such 

Overlapping 
Notes (Chord) 
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as 3xOSC (to pitch bend VST instruments you can automate the pitch knob for the Channel 
it’s loaded into, remember Event editing?). If you click on the Slide Icon in the top left just 
under the Edit Menu Button, you can insert pitch-bending notes (also called Slide Notes).  To 
see how this feature works, place a long note on the PR, and then place a slide note above or 
below it.  Make sure the two notes overlap.  The long note will play until it reaches the slide 
portion.  Then the pitch will rise towards the Slide Note and stay there until it reaches the end 
of the original note. The longer the Slide Note, the longer the slide. 

 

 
 

8. Tweaking the Notes.  Remember the Graph Editor from way back in the Step Sequencer 
section?  It let you individually change Volume, Cutoff, Resonance and so on for each note.  
The Piano Roll has a similar function, laid out in the bottom part of the Piano Roll Editor.  
Every time you enter a note, you get a spike in the bottom graph that shows the level of the 
parameter selected by the drop down box on the left (labeled Event Select above).  After you 
enter the notes, you can change the values of any of the parameters by grabbing the top of the 
spikes and dragging them. The horizontal line shows note length. You can set Velocity, Pan, 
Cutoff, Resonance, and Pitch.  As an added bonus, you can also use this graph as the Event 
Editor for Channel Pan, Pitch, and Volume.  NOTE: You can also change any note’s 
properties by double-clicking it. 

 
9. Importing MIDI Tunes.  In the File Menu under MIDI, you'll find two methods of 

importing MIDI sound files directly into the Piano Roll Editor. There are tons of MIDI files 
for various popular melodies floating around out there.  Now you can suck them directly into 
FL Studio and use them in your songs.  How cool is that? 

Slide 
Icon 

Note 
Starts 
 
Slides  
Up 
 
Slides 
Down 
 
Then 
Stops 

Select 
event 
above 
 
Edit 
below 
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TTTTTTTTHHHHHHHHEEEEEEEE        PPPPPPPPLLLLLLLLAAAAAAAAYYYYYYYYLLLLLLLLIIIIIIIISSSSSSSSTTTTTTTT        ((((((((ffffffffrrrrrrrroooooooommmmmmmm        PPPPPPPPaaaaaaaatttttttttttttttteeeeeeeerrrrrrrrnnnnnnnnssssssss        ttttttttoooooooo        SSSSSSSSoooooooonnnnnnnnggggggggssssssss))))))))        
 

Now you've seen the basics of what can be done with sampled sounds in a single pattern. In this 
section we'll show you how to program more than one pattern and link them together into a 
longer loop.   
 
1. The Pattern Selector.  FL Studio lets you create 999 different patterns of any length. In the 

previous sections, we've just been working with pattern 1, but we can access the other 
patterns by changing the number in the Pattern Number box. Use your mouse to drag in the 
Pattern Selector or use numeric ‘1’ till ‘9’ or  ‘+’ and ‘-‘). You’ll find these controls 
somewhere on the tool bar at the top of the main FL Studio window. Right-click the pattern 
selector to show all patterns with data in them.  

 

 
 
 
                         

 

2. Check out the Playlist. This screen can be opened either using the button under the hint bar,  
by hitting F5, or by right-clicking the song/pat button on the main screen (see above). Try it, 
and you should get a new window that looks something like the one shown below. This 
window is similar to the pattern view, except that the steps operate on whole patterns rather 
than single Channels, and the bar lengths here vary to reflect the pattern length. Make sure 
Song is selected and press Play. You should see the Play Indicator on the Playlist start to 
move, and hear the patterns it is playing (use the NewStuff.flp). When the indicator reaches 
the end of the steps, it will jump back to the Song loop point and continue playing. Try 
moving the loop point (right-click where you want it to go) and see what happens. (If you 
press the Pat button, FL Studio will just repeatedly play the current pattern in the Step 
Sequencer.) 

 
Groovy. 

Pattern  number 
box 

Pattern/Song   
mode selector 

Play position indicator 
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To add Clips to the Playlist use the ‘Pattern selector’ & then click on empty Playlist tracks. 

 
3. What's the Point? Now you can assemble a number of patterns together to make a song.  

This lets you alter melodies, change beats, insert fills, and reuse some of the early parts of 
the song later.  The clip tracks show information about the data patterns & clips contain. The 
It’s up to you how you want to work but many composers use separate patterns for drums, 
bass, lead, etc. so they can work on them separately at first, and then piece the song together 
in the Playlist. A good way to see the Playlist used ‘full-on’ is to see the NewStuff.flp or 
flp’s in the ‘Cool Stuff’ folder in the browser. 

 
 

4. Data types: Each Clip track can hold unlimited number of Automation Clips, Pattern Clips 
and Audio clips. To add a new instance of a clip select the clip to paste using the Clip 
‘Pattern selector’ and then click in an empty place inside the tracks. Try moving the waves or 
cutting them with the slice tool. You can find more tutorial projects explaining how to use 
them and also plenty of information in the on-line help (focus FL Studio and press F1). See 
more info in the chapter Audio Tracks. You can apply automation envelopes (e.g. to fade the 
volume in/out on an audio clip) on top of these audio clips. 

I get it! The Playlist has a bunch of general purpose ‘Clip tracks’ the controls to 
the left of the tracks are for naming and muting. Then the musical note, sample 
and automation data can be laid out in any of the Clip tracks (they are not fussy 
about what they contain) easy;I think; what was that again?! 
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AAAAAAAAUUUUUUUUDDDDDDDDIIIIIIIIOOOOOOOO,,,,,,,,        PPPPPPPPAAAAAAAATTTTTTTTTTTTTTTTEEEEEEEERRRRRRRRNNNNNNNN        &&&&&&&&        AAAAAAAAUUUUUUUUTTTTTTTTOOOOOOOOMMMMMMMMAAAAAAAATTTTTTTTIIIIIIIIOOOOOOOONNNNNNNN        CCCCCCCCLLLLLLLLIIIIIIIIPPPPPPPPSSSSSSSS        ((((((((EEEEEEEEDDDDDDDDIIIIIIIITTTTTTTTIIIIIIIINNNNNNNNGGGGGGGG))))))))                                
 

 
FL Studio Producer Edition lets you work with Audio, Pattern and Automation Clips. Fruity 

Edition allows Pattern Clips only. Express Edition is Stepsequencer only. 
 
To place an audio/automation & Pattern Clips, switch to draw or paint mode and left-click in 
an Clip track (To pain Audio and Automation Clips, they need to exist in your project before you 
will be able to paint one in, otherwise you can drag a sample onto the Playlist and an Audio clip 
will be automatically). Paint mode allows you to draw multiple instances of the audio clip at once 
(hold the mouse button and drag). 
 
To erase a clip, click it with your right mouse button or use the left mouse button in erase mode. 
 
To switch a clip instance to play another, open the clip menu (left-click the arrow in the top left 
corner of the clip) and from the Select Channel menu, pick a replacement Clip. 
 
To open the Channel Settings of the Channel associated with the clip instance, open the clip 
menu and select Channel Settings. 
 
To audition an Audio clip select Preview from the clip menu to listen to the audio clip sample 
(hit the Stop button in the Transport panel to stop the preview). 
 
Automation Clips can automate any editable parameter over the complete song (instead of Event  
based automation). A common use of these Automation Clips is to make a fade-in/out for an 
audio clip by automating its volume. However, the use of Automation Clips has a much bigger 
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scope than controlling the clips volume. Feel free to experiment with its use. Use the appropriate 
switch to switch between Audio clips, Automation Clips and Pattern Clips handling. 

        

There are LOTS of keyboard shortcuts and tool modifier keys that make 
working with the Playlist really fast. For example you can hold the Shift key 
while using the Pencil or Brush tool and their action will swap with each other. 
You can also hold the Right-Shift key and click to slice a Clip OR hover your 
mouse cursor and press the Insert key to do the same. The Alt key releases 
snapping while you hold it. Press F1 and check the manual for more! 
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IIIIIIIINNNNNNNNSSSSSSSSTTTTTTTTRRRRRRRRUUUUUUUUMMMMMMMMEEEEEEEENNNNNNNNTTTTTTTTSSSSSSSS        ((((((((ffffffffrrrrrrrroooooooommmmmmmm        ssssssssaaaaaaaammmmmmmmpppppppplllllllleeeeeeeessssssss        ttttttttoooooooo        ssssssssyyyyyyyynnnnnnnntttttttthhhhhhhhssssssss))))))))        
 

Until now we've only been playing mainly with Sampler Channels.  Useful but fairly basic as far 
as sound generation goes. FL Studio also supports Channels that contain sounds made in real time 
by software synthesizers like 3xOSC, Wasp, SimSynth Live, PoiZone, Sytrus, Harmless e.t.c.  
To use the proper terminology, every Channel contains an Instrument (sometimes generally called 
a ‘generator’), that can either be a sample (in a Sampler Channel), a synthesizer plugin, or some 
other type of instrument in combination with the effects in the Channel Settings window. The 
combination of these Instruments with the sample Channels gives FL Studio a major sonic boost!   
 
1. Adding a Synthesizer Channel. To add a Channel containing a synthesizer Instrument, click 

on Channels > Add One as shown below and select one of the many instruments available, 
such as Audio Clips, Automation Clips, 3xOsc, Autogun, BeepMap, BooBass, Buzz 
Generator Adapter, Chrome, Dashboard, DirectWave, FL Keys, FL Slayer, FPC, Fruit 
Kick, Fruity DrumSynth Live, Fruity DX10, Fruity SoundFont Player, Sytrus, 
Plucked!, SimSynth, Wasp and many others (the list of instruments is growing with each 
release!). You can also download and install many FREE VST instruments from the web.  
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2. What to Expect. The new Channel will appear in the Step Sequencer and the Instrument's 
Configuration Screen will appear.  If the Configuration Screen is small, it will appear inside 
a Channel Settings window (3xOsc, BeepMap, Fruit Kick, Fruity SoundFont Player, 
Plucked!).  Otherwise, it will appear as a standalone window (Autogun, BooBass, Buzz 
Generator, FPC, Fruity DrumSynth Live, Fruity DX10, Ogun, SimSynth Live, Wasp, Sytrus, 
Poizone, Sawer, Toxic Biohazard).     

 
3. How Do I Use them? It's important to know that most Instruments have their own help 

available.  If the Configuration Screen for the Instrument is embedded in a Channel Settings 
window, click on the Channel name.  If it's in a standalone window, click on the menu in the 
top left corner.  

 
 

                            
 

 

4. Preset Sounds.  Most synthesizer instruments (BeepMap, Buzz Generator, Fruit Kick, Fruity 
DrumSynth Live, Fruity DX10, SimSynth Live, Wasp) have preset sounds available.  In most 
cases, you can get to them from the Presets section of the menu shown above, or by clicking 
on the little arrows in the top right (see picture above-right). Right-click to see the big list. 

5. Channel Settings.  All these instruments have a Channel Settings window that you get by 
clicking on the Channel name, just like for Sample Instrument Channels.   
But since each instrument is different, they may not all have the same panels as the Sample 
Instruments do.  For instance, the TS404 has the SMP, MISC, and FUNC panels, while the 
BeepMap instrument has INS, MISC, and FUNC. 

 
6. What do these Instruments Do?  OK, here's the skinny on the Instruments. Please note that 

some of these Instruments need to be purchased separately. If you haven’t bought them, 
you’ll only have the demo version of the Instrument that will allow you to play and listen to 

Preset Sounds 

Help 
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their sounds, but these Channels will not be saved in your FL Studio project. Some demo 
instruments (and effects) may make a soft hissing sound every so often. If you can hear 

something that sounds like the ocean, you probably have a demo loaded somewhere in 

your project.  

a. 3xOsc (included). This is a plain instrument that allows you to mix three 
Oscillators, each of which generates a tone.  The sounds on their own are not 
exciting, but they are good raw material to be combined with INS panel effects and 
other plugin effects (explained in a later chapter) and it’s a great place to start if you 
are new to synthesis. 

 

 
 

b. Autogun (included) is a universe of sounds waiting to be discovered. Based on the 
Ogun synthesizer engine and Soundgoodizer effects processor, Autogun contains 
4294967296 presets (Four Billion Two Hundred Ninety Four Million Nine Hundred 
Sixty Seven Thousand Two Hundred Ninety Six), most previously unheard my man 
(or woman, are there girls here? quick get their phone numbers!). 
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c. BeepMap (included).  This is a weird one.  Takes a bitmap image file and turns it 
into a sound, with strange and wonderful results. This is the same kind of synth that 
Aphex Twin used to embed an image of himself in a track that shows up when the 
track is put through a spectrum analyzer. 

 

d. BooBass (included). A handy little bass instrument from the guy who brought you 
SimSynth. 

 

 

 

Dashboard (included). Allows you to create your own MIDI and Internal Controller interfaces 
(check the on-line help to see what internal controllers are about). 

 

 

e. FL Keys (included). A realistic piano simulator with optimized CPU and memory 
usage. 
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f. DirectWave (player version). A powerful sampler featuring a fully programmable 
synthesis section, with all the usual sampler goodies. DirectWave can also 'sample' 
(record sound) when loaded into a Mixer track on an effect slot. 
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g. FL Slayer (included). A realistic electric guitar simulator equipped with a quality 
amp section and effects rack enabling you to recreate the complete electric guitar 
sound without additional plugins. 

 

 
 

h. FPC (FL Pad Controller, included). A software plugin similar to the hardware Akai 
MPC unit, coded & optimized for the FL Studio platform. FPC is a self-contained 
multi-layer/velocity drum machine that makes it easy to create, edit and swap drum 
kits on the fly. FPC supports 16 multi-layered patches for banks A and B. 
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i. Fruit Kick (included). A kick drum instrument. 

 
 
 

j. Fruity DrumSynth Live (demo for Express edition). A Drum Synthesizer plugin 
that lets you define drum hits and control them via a keyboard.  

 
 
 

k. Fruity DX10 (demo for Express edition). An 8-voice polyphonic (that means 8 
notes at once) FM Synthesizer. This one’s designed to give high quality sounds 
without eating up too much CPU. 
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l. Fruity Envelope Controller (included). Allows you to trigger envelopes that may 
be linked to parameters in FL Studio. Includes an envelope editor, similar to that 
used in Sytrus and FPC. 

 

m. Fruity Granulizer (included). This one helps you get cool, choppy sounds out of 
your samples.  

 
 

n. Harmless (demo). Performs subtractive synthesis using an additive synthesis 
engine. All sounds complex but it’s an easy synth to get great sounds out of. 
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o. Morphine (demo) .  A powerful Additive Synthesizer with a logical, flexible 
architecture that allows you to create any sound. You can do this directly by 
adjusting harmonics manually or by taking any input sample and resynthesizing it 
into one of 4 independent voices. 

 

 
 

p. Ogun (demo) can produce exceptionally rich metallic and shimmering timbres, 
although it's not limited to this genre. Ogun’s distinctive synthesis engine can 
generate more than 32,000 harmonics, modulated by high-level ‘harmonic mapping’ 
functions, that hand tonal control directly to the user. 

 
 

q. Toxic Biohazard (demo). Features a hybrid synthesis engine, combining the best of 
FM and Subtractive synthesis. With warm, analog-modeled filters and set of built-in 
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effects, Toxic Biohazard is convenience, simplicity, and superb sound quality. 
 

 
 

r. Fruity Keyboard Controller (included). An automation control which makes no 
sound of its own, but can be used to control knob and sliders within FL Studio, by 
mapping note pitch and velocity from the Piano roll or Step sequencer to any 
automatable parameter or third-party plugin. 

 

s. Fruity Slicer (included). This one lets you slice up a beat and then play back 
individual drum hits using the keyboard. You can make cool breaks really quickly 
with this tool.  
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t. Fruity SoundFont Player (inc. in Signature Bundle). An advanced sample 
instrument that works with the SoundFont2 collection. 

 

u. Fruity Vibrator (included). You can add vibes to your songs using any Force 
Feedback (.ffe) file. These files can be created using Microsoft Force Editor tool in 
the DirectX Developer SDK. 

 

 
 

v. Poizone (demo). A subtractive software synthesizer designed to bring you 
professional quality results, without a learning curve that hinders your creativity. 
The concept behind PoiZone was to design a synthesizer that had the smallest 
number of controls while providing the maximum flexibility and features 
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w. Plucked! (Included) A synthesizer that produces specialized stringed instrument 
sounds like guitars, harps, mandolins, etc. 

 
x. Sawer (demo) is a  vintage modeling synthesizer, that can cut through a mix with 

precisely articulated and punchy sounds. 
 

 
 

y. SimSynth Live (demo for Express edition). A fully functional digital synthesizer.  
Use this baby to create phat-sounding analog sounds for your dance and trance 
tracks. 
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z. Slicex (included – producer edition and higher) uses advanced beat detection 
algorithms to slice song/percussion samples into pieces and make them 
independently playable from the Piano roll or controller. If the wave file contains 
slice/region data this will be automatically used instead of the beat-detection 
algorithm. Slicex offers playback, reordering of slices and time-stretching 
capabilities optimized for drum loops. 

 

 
 

aa. SynthMaker (included – producer edition and higher). Hang onto your hats! 
SynthMaker is an audio programming application that is used to create virtual 
instruments and effects without the need to write basic code. The instruments and 
effects you create in SynthMaker can be used in FL Studio as 'native' plugins and 
shared with other SynthMaker users 
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bb. Sytrus (inc, in Signature Bundle). Sytrus the most versatile synthesizer in the FL 
Studio armory, combining Frequency Modulation (FM), Ring Modulation (RM), 
plucked string modeling and subtracting synthesis, and featuring a powerful 
envelope editor. The synth includes a powerful editable unison mode and a 
comprehensive effects section. 
 

 
 

cc. TS404 (included).  Is a great ‘techno’ machine for creating synth lines and bass 
lines, which sound similar to the classic TB-303 machine (look under ‘more’ in the 
Add one pop-up). 
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dd. Wasp (demo for Express edition). Another full digital synthesizer. This one creates 
fast, buzzing, techno-oriented sounds (hence the name). 

 
 

ee. WaveTraveller (included). Create realistic scratches with a full control over the 
smallest details! 

 
                          

ff. Layer (included). This isn’t really a Instrument, but it’s cool. It lets you create an 
instrument  Channel to control a bunch of other instrument Channels at once. 
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gg. MIDI Out (included). This one isn’t a Instrument either. It lets you send a MIDI 
controller signal to an external (or internal) MIDI device. 

 

hh. Speech Synthesizer (included).  This is a wizard to add synthesized speech lines to 
your song (see p.39). 

ii. Others. There are a few other instruments, see the FL Studio Help (F1). 
 

 
7. Even More Instruments! With the Fruity Wrapper you can additionally add any VST or DX 

plugin synthesizer you download or buy. From the Channels menu select 1. Add One > 2. 
More. This will produce a list of the available plugins as shown below. You can select any of 
the plugins under the Fruity Generator Plugins heading by double-clicking them.  The “F” 
in the box beside the plugin name marks it as a “Favorite” and will make it appear directly in 
the Add One menu shown below. If you have added a new plugin to your VST search 
directory (F10 File settings in FL Studio), you may need 3. Refresh and 4. Fast scan, to see 
your new plugin appear in the ‘More…” list. 

 
 

Favorite list 

Favorite switch 

New plugin 
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8. VST and DX Plugins. You may have noticed the Fruity Wrapper in the above list of 
plugins. The wrapper is not strictly an instrument but provides the interface between FL 
Studio and VST or DXi plugins.  If you double-click on one of the VST Plugins, it will 
automatically open the Wrapper for you. You may notice that some plugin instruments (and 
effects) don’t have their own interface, see the DX10 freeware plugin below. This uses the 
generic ‘wrapper’ interface. Others have a more professional looking interface, like Poizone.  

 

 
 

 

 

 

 

 

 

 

 

 

 

9. The Other VST Plugins. What about all the other VST Plugins in the list? VST plugins are 
either synthesizers or effects (FX), we explain how to use the FX in the Mixing & Effects 
section below. VST’s are held by the FL Studio ‘Wrapper’. 1 = Wrapper menu. 2 = Plugin 

settings (useful to set multiple outputs or 
whip misbehaving plugins into shape!). 3 
= Preset selector. 4 = Close interface. 
Unfortunately, there is just no way for FL 
Studio to tell the difference between FX 
and Synth plugins, so you’ll just have to 
remember which is which.  If you try to 
open a VST Plugin and all you get is an 
error message and the empty wrapper, 
then it was probably an FX plugin.  

Generic interface (DX10). 

Custom interface (PoiZone). 



 

 50 

 

10. Do I have to demo plugins to use them? We fund the lifetime free updates program by 
selling some additional plugins to our loyal customers, so yes in some cases you do have to 
register them to unlock their full capabilities. By doing so you support not only Image Line 
Software but the whole FL Studio community. Go to http://flstudio.image-line.com for more 
information on where to send your hard-earned cash. 

 
11. Where Can I Get More? There are literally thousands of synth plugins out there to 

download.  Some of them are free, and some you have to pay for.  Search the web and 
http://flstudio.image-line.com or http://www.image-line.com for good deals.  A place you 
should definitely bookmark is http://www.kvraudio.com - a huge site with details about every 
VST plugin you could possibly want (new VST Plugins should go in the shared Program 
Files\Image-Line\ VST directory on your hard drive). 

 
12. The Arpeggiator. Now that we've introduced the Synth instruments, we can tell you more 

about the Arpeggiator section in the Channel Settings window.  Open one of the synth 
Channels (SimSynth Live, for instance) and go to the FUNC panel of the Channel settings 
box.  Now click the up arrow and select a chord.  Now go to a new pattern and place a 
single SimSynth note and press play.  Instead of a single note, you get a repeating arpeggio.  
Cool, huh?  Read more about this in the on-line help. 

Don't deny yourself, dude!  You need all the  Instruments. Save up 
your squeegee money and buy them ASAP. Probably the one that will 
make the most difference to your tracks is Sytrus and while we are on 
the topic, don’t forget Maximus effect, this Maximizer plugin rocks! 
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13. Speech!  Yep, you read that right. You can have a conversation with FL Studio using the 
built in support for speech synthesis.  The easiest way to access this feature is to look under 
“speech” in the sample browser, and drag one of the files there onto the step sequencer. 
You’ll get a dialog that looks like the one below. All you have to do is replace the text, 
choose a personality, style, rate (speed), and pitch. Click the “listen” button to hear what it 
will sound like. When you’re done, press the check mark and a sampler Channel will be 
added. You can also drag a speech file into a Granulizer, Fruity Scratcher, or Fruity Slicer 
Channel. Have fun. 

 

Direction of 
Arpeggio 

Chord Selection 

Octave Range 
and Repeat 
    

Speed, 
Duration, etc. 

The Arpeggiator works best when you play 
the instrument hosted by the Channel using 
a MIDI controller, like what I have here in 
my hands. Sweeeeeeeeeeeet! 
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You might have to spell some words strangely to make it 
sound ok. You can make it sing by putting the number of 
semitones you want the pitch to rise on each word in 
brackets after it. Try typing “all your(-2) base(3) are(2) 
beelong to us” in the dialog above (use a monotone style.) 
Numbers in brackets are pitch modifiers. 
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MMMMMMMMIIIIIIIIXXXXXXXXIIIIIIIINNNNNNNNGGGGGGGG        &&&&&&&&        EEEEEEEEFFFFFFFFFFFFFFFFEEEEEEEECCCCCCCCTTTTTTTTSSSSSSSS                
One great feature of FL Studio Producer Edition is Mixer window. From here you can mix 99 
‘regular’ tracks and make links between Mixer tracks to create complex mixing chains. Take a 
deep breath!  

One of the best features of the Mixer is that you can add effects to the sounds coming from the 
Channels. Effects can range from a simple volume changes to more advanced effects such as 
chorus, reverb, phaser, delay, flange, and EQ, among others (you can also add instruments, 
notebooks, controllers, monitors and all kinds of other goodies!).  
 
Open the Mixer Window.  Bring up the Mixer screen by pressing F9 or by going to View > 
Mixer. You'll get a window like the one below… 
 

 
 

What are you looking at?  On the left side are the standard Mixer Tracks. You have one Master 
Track (M in the header), 99 Standard Tracks, 4 dedicated Send Tracks and 1 Selected Track, 
although any Mixer track can act as a send. The edge of the Mixer may be clicked-on and 
dragged to show all 99 Mixer tracks (if your screen is wide enough!). Alternatively, there is a 
slider in the top left corner of the Mixer to scroll across the tracks. The Master Track is selected 
by default (although in the picture above track 1 is selected as shown by the lighter color). Each 
track has room for eight effect (FX) Plugins (above right). When you change the selected track 
(by clicking on it) the FX bank will show the effects loaded into that track.  
 
The Track Controls panel show the properties for each selected track. The volume and stereo 
balance settings are the linked to the corresponding knobs below each track (these are 
independent of and in addition to the pan & vol knobs on the instrument Channels, page 11). 
Some of the other things on the Track Controls panel are a 3 band parametric equalizer, stereo 
width knob, phase switch, swap L/R switch and a large sound level meter (shows the output 

Mixer 
tracks 

FX Plugin 
slots 

Track 
controls 

Send  
knobs 

Master 
track 

Scroll tracks 
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volume of the track). 
 

Turn Plugins On and Off / Mixing Wet and Dry.  Click on the green LED on the right of each 
plugin slot to turn it on and off.  Try this with the loop running to hear the difference. You can 
also tweak the knob next to the LED to mix a “dry” (without effect) and “wet” (with the effect) 
sound. 
 
Select Plugins. If you want to add new plugins, click on the down arrow (1) on the FX slot where 
you want to add the plugin and then choose from the Favorites List (below 2) or choose Select 
More (2) to choose from the entire list and configure your favorites. If you have added a new 
effect plugin to your VST search directory (F10 File settings in FL Studio), you may need 3. 
Refresh and 4. Fast scan, to see your new plugin appear in the ‘More…” list. 
 

 
 

Tweak the Plugins.  Left-click on the plugin name to open and close its Plugin Settings screen.  
Some plugins have a generic interface like the Fruity Reverb.  Others have fancier looking 
controls (like Fruity Limiter).  Most plugins come with their own help as shown below, so we 
won't go into how to use the controls here.  Why not play with them all to see what they do? 
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Sending Sound to the Mixer. The box in the top right of the Channel Settings (below, remember 
left-click on a Channel button to open this window) is a Mixer track ‘send’. Any effects placed in 
the Master Mixer Track will be applied to all the sounds in the song.  But effects in Mixer Tracks 
1-99 will only be applied to the Samples and Synths, which have selected that Mixer Track in 
their Channel Settings Dialog.   
 

 
 

What are the Send Tracks For? Economy & convenience! There are 4 ‘Send Tracks’ that take 
their input from other Mixer tracks, rather than from Instrument Channels. Suppose you want to 
put the same Fruity Reverb on Guitar and Drums, but you want to add Fruity Delay to the guitar 
and EQ to the drums. Easy. Send the drums to Regular Mixer track 2 where you put the EQ. Send 
the guitar to Regular Mixer track 3 where you put the Fruity Delay. Then put the Reverb in Send 
Track 1 and turn the Send 1 knob on Mixer tracks 2 and 3 to send the output of these tracks to 
Send Track 1.  Now you have the same reverb applied to both guitar and drums, but you only had 
to use a single reverb plugin.  The send knobs are placed beneath the track receiving the input 
not the track sending. An orange down-arrow shows the source track. Note: since any Mixer 
track can send to any other, you can have more than 4 ‘send’ tracks.  

Left-click here 
to open the FX 

Click Here for help 

Sending to  
Mixer track 2 

Effects have presets too! 

Click here to enable / 
disable FX 
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Changing Plugin Order.  The order in which you add effects plugins decided in what order the 
FX are applied to the signal. Think of it this way – the signal enters the top of the FX stack and 
leaves the bottom. So Delay above a reverb would mean the delay sits in a wash of reverb. 
Reverb above delay means the reverb tail is chopped up and delayed. To make it easier to 
experiment with effects order, FL Studio has a simple function to move an effect up or down in 
the effects chain. A quick way is to place your mouse cursor over the FX slot and scroll your 
mouse wheel. No wheel? Click the FX menu and press ‘u’ or ‘d’ on your keyboard to move 

the selected FX. 
 

 
 
What do the Plugins Do?  As mentioned, you can get on-line help for all of the FL Studio Plugins, but 
here's a quick rundown on what they all do –  
 

Buzz Effect Adapter. Lets you load in any Buzz Machine effect. FL Studio comes with a 
few installed already, but you can get more at http://www.BuzzMachines.com. 
 

Edison. A fully integrated audio editing and recording tool. Edison loads into an effect slot 

This is the ‘source’ 
track and is sending 
audio to 2 other 
tracks,  tracks (a 
regular & ‘send’ 
track).  

These two tracks receive input, note the knob positions that show the input 
signal volume, click on the up-arrow to make send knobs appear/disappear. 

Dedicated 
‘Send’ tracks. 

Place your mouse 
pointer over the FX 
name and scroll the 
wheel OR Left-click 
and press ‘u’ or ‘d’ 
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(in any Mixer track) and will then record or play audio from that position (see page 069 for 
more info). 
 

EQUO. Is a bank of 8 Graphic Equalizers with between-bank morphing, particularly suited to 
automation. 
 

Fruity 7 Band EQ (included). Equalizes your sound (just like on your Dad's stereo at 
home.) 
 
Fruity Balance (included).  Lets you change the pan and volume while live recording. 
 
Fruity Bass Boost (included). Boost that bass for a super-phat sound. 
 
Fruity Big Clock (included). Pops up a huge timer to tell you how long the song’s been 
playing. 
 

Fruity Blood Overdrive (included). Use this to distort Channels. 
 
Fruity Center (included). Use for real time DC offset removal. 
 
Fruity Chorus (included). Adds a smooth chorus effect. 
 

Fruity Compressor (included).  Use this to flatten out the dynamics of the sound. Many 
producers today use massive compression to get their drums to sound the way they do. 
 
Fruity dB Meter (included). Pops up a big levels meter. 
 

Fruity Delay (included). Use for a true echo (not just repeated samples like the Channel 
echo).  
 
Fruity Delay 2 (included). The next generation Fruity Delay. Adds panning and other 
effects. 
 
Fruity Delay Bank (included).  Consists of a bank of 8 identical banks, each is able to be 
feed to the next bank in the chain in order to create complex delay and filtering effects.   

 

Fruity Fast LP (included). Use for low pass filtering that's CPU friendly (cutoff and 
resonance). 
 
Fruity Fast Dist (included). A great little distortion effect that uses almost no CPU.  
 

Fruity Filter (included). More cutoff and resonance filtering that’s not so CPU friendly. 
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Fruity Flanger (included). If you have to ask, you haven't heard it yet.  Real popular among 
guitar players, this LFO-type effect can add a cool feel to any song. 
 
Fruity Flangus (included). A very useful effect, which allows you to enrich the stereo 
panorama of your instruments, add high quality chorus and simulate unison synthesis. 
 
Fruity Formula Controller (included). This is a fancy internal controller that you can link 
to other knobs and sliders inside FL Studio.  Wait until the Live Recording section for more 
info...  
 

Fruity Free Filter (included). Yet another filter - a classical 12db instead of a state variable 
filter like the Fruity Filter (whatever that means?)  
 

Fruity HTML Notebook (included). Add some notes to your loop in html format, or add 
your own web page!  
 

Fruity Love Philter (included). The most powerful filter plugin in FL Studio. Consists of 8 
identical filter units, each able to be feed to the next one in the chain. Creates complex delay, 
gating and filtering effects. 
 
Fruity LSD (included). Enables FL Studio to access the DirectMusic Software Synthesizer 
bundled with DirectX 8. Note that you must have DirectX 8.0 or later installed on your 
machine. The LSD acts like an external MIDI device, which can be controlled from a MIDI 
Out Generator Channel (see section on Instruments above). 
 
Fruity Limiter (included). . Single band Maximizer, Compressor & Limiter.  
 
Fruity Multiband Compressor (included). A 3-band stereo compressor using ButterWorth 
IIR or LinearPhase FIR filters to separate the incoming signal into three bands for processing. 
Limiter functionality is also included. 
 

Fruity Mute 2 (included). Use this to mute (silence) Channels while live recording. 
 
Fruity Notebook (included). Keep your song notes here!  This is the plugin used in the 
Tutorial Loops that came with your package. 
 
Fruity PanOMatic (included). Useful for panning the sound back and forth smoothly.  
 

Fruity Parametric EQ (included). A parametric equalizer built for FL Studio. Regular 
equalizers only let you set the levels for preset frequency bands, but with a parametric 
equalizer you choose the frequency bands to equalize.  
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Fruity Parametric EQ 2 (included). An advanced 7-band parametric equalizer plugin with 
spectral analysis. The frequency and width of each band is adjustable, along with the band 
type. Useful for when you need precise control over EQ.  
 

Fruity Peak Controller (included). This is another internal controller. More on controllers 
in the Live Recording section below.  
 

Fruity Phase Inverter (included). Use to reverse the stereo phase (left and right). 
 
Fruity Phaser (included). Like the Flanger, but even cooler. 
 
Fruity Reeverb (included). Use for a much nicer reverb than you can get on the Channel 
Settings dialog. 
 
Fruity Reverb 2 (included). New and improved Reverb plugin with higher quality sound 
and more controls than the original reverb.  
 

Fruity Scratcher (included). Load up a sample and scratch the hell out of it. This plugin is 
actually more like a instrument, since it produces sound on its own rather than modifying a 
Channel. 
 
Fruity Send (included). Place this plugin between two other plugins to split the signal and 
send it to one of the four  Send FX Channels.  
 

Fruity Soft Clipper (included). This is a CPU friendly soft limiter filter. It allows you to 
avoid clipping and distortion by applying soft compression to the input signal. 
 

Fruity Spectroman (included). Pops up a spectrum analyzer so you can view the spectral 
distribution of the sounds in your track. 
 
Fruity Squeeze (included). Is a bit reducing, distortion and filtering plugin. Fruity Squeeze 
will add a gritty tonal character to input sounds and is particularly effective when applied to 
drum loops. 
 

Fruity Stereo Enhancer (included). Adds some really nice stereo separation and other 
effects. 
 
Fruity Stereo Shaper (included). . More sophisticated version of the Stereo Enhancer with 
MID/SIDE decoding (warning this one will bend your mind!)  
 
Fruity Vocoder (included). An advanced vocoder with a wide range of adjustable 
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parameters and zero latency (i.e. the vocoded sounds are not “late”). This effect uses quite a 
lot of CPU with slower machines but has unique precision and features. 
 
Fruity WaveShaper (included). Is a wave distortion effect which maps input to output 
values using flexible spline-based graph. 
 
Fruity X-Y Controller (included). Yet another internal controller you’ll learn more about in 
the Live Recording section below. 
 
Gross Beat (demo). Time manipulation/rearranging effect. 
 
Hardcore (incl. in Signature Bundle). Guitar effects suite. 
 
Maximus Multiband Maximizer (incl. in Signature Bundle). 3 band compressor limiter. 
Powerful maximization. No-one should enter the loudness wars without it ☺ 
 
Newtone (demo).  Pitch editor and correction. 
 
Pitcher (demo). Realtime pitch correction and harmonization. 
 
Soundgoodizer (included). Free maximizing and soundgoodizing plugin.  
 

Preset Effects. If a plugin has built in presets you can access them through the presets section of 
the effects menu as seen above, or by using the little arrows (top right corner of the plugin 
window) as with the synthesizer plugins. You can create your own presets by clicking save 
preset.  When you do this, FL Studio saves the positions of all the plugin controls so that you can 
get that exact effect sound back again later.  If you save your presets in the directory FL Studio 
suggests, then it will appear on the menu under presets.  
 
Getting New Plugins. FL Studio has a great selection of FX Plugins but people are always 
creating new ones, and you can find many of them on the web.  Some are free and some cost 
money.  Surf the web (kvraudio.com is a great place to start) and see what you can find! The on-
line reference (press F1 in FL Studio) contains in-depth step-by-step guides on how to install and 
use such third party plugins. 
  
CPU Considerations. "Woh! I can use as many plugins as I want?!?" Actually, no you can’t. 
Each plugin you use takes up a certain amount of your computers power. Some take more power 
than others. The number of plugins you can use before your computer starts grinding and running 
out of breath depends directly on your CPU speed. There is no formula for how many plugins you 
can use, but if the sound starts breaking up after you add a plugin, it’s a good sign that you’ve 
gone a few plugins too far.  Don’t forget that adjusting the Buffer Length (F10 Audio settings) 
can often solve your CPU problems (see the “First Run” section page 7). 
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RRRRRRRREEEEEEEECCCCCCCCOOOOOOOORRRRRRRRDDDDDDDDIIIIIIIINNNNNNNNGGGGGGGG        LLLLLLLLIIIIIIIIVVVVVVVVEEEEEEEE        KKKKKKKKNNNNNNNNOOOOOOOOBBBBBBBB        MMMMMMMMOOOOOOOOVVVVVVVVEEEEEEEEMMMMMMMMEEEEEEEENNNNNNNNTTTTTTTTSSSSSSSS        ((((((((AAAAAAAAuuuuuuuuttttttttoooooooommmmmmmmaaaaaaaattttttttiiiiiiiioooooooonnnnnnnn))))))))                        
Did you know you can record any movements you make to any knob?  It’s called ‘Automation’ 
and it's the key to making your songs come alive.  So, let’s record some automation. Open the 
Channel Settings for an simple Channel instrument (like a snare sound), and click on the INS tab.   
 

 
 

 

1. Choose an Automation Pattern.  OK, this is important.  Automation is easily misplaced so 
it’s good to record all it into a single pattern, that’s why we have one pre-named ‘Main 
automation’ in the Block Track (lower) Playlist. You need to place that pattern in the Playlist 
at the beginning of the song to play back the live tweaking (if you place it in the ‘Clip Track’ 
(upper) Playlist you will be able to see the automation in the clip.  As you learn more about 
what you are doing, you can break out of this mold, but you need to start simply. 

 
 

 
 
 
 
 
 

Click the INS Tab 

Watch this 
knob move! 

Remember to select the right 
Pattern AND have the Automation 
recording mode ON! (right-click the 
record button and tick). It doesn’t 
matter if the others are also ticked. 
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2. Record Some Live Tweaking.  The easiest thing to do is create a new flp (File > New), lay 
down some drum loops and practice playing with the Channel PAN and VOL knobs of the 
snare (for example).  When you think you've got something groovy, make sure you've 
selected the Main Automation pattern and have selected Automation recording in the 
right-click menu on the record button, then press the Record Switch shown below.  You may 
hear a three-tick countdown first, depending on whether the 321-countdown light is on. Then 
start the song and work your magic.  The song will play once and then stop.  Turn recording 
off and press Play (in Playlist mode, with your pattern in the Playlist. You've just done your 
first Live Recording session! 

 
                                       
 

 
 

3. Set the Buffer Length low.  If you noticed a delay between tweaking knobs and FL Studio's 
response you may need to lower your buffer settings (hit F10 and select the Audio tab).  The 
lower you set this slider, the faster FL Studio will respond.  But don't set it too low, or the 
sound may get choppy (see the "What are You Lookin' At?" section). 

4. Important Note. When you've got the Recording Switch on and the loop is playing, moving 
a knob will erase over all the previously recorded tweaks from that point in the song until the 
end.  This can be frustrating, so often it's best to get the recording approximately the way you 
want it and then make further changes in the Event Editor described in the next section. 

5. What can be Recorded? Most knobs and sliders are recordable, including those that control 
Plugins.  But some controls aren't recordable.  The quickest way to tell what's recordable is to 
mouse over a control and look for the red steps in the Hint Bar.  If these steps appear, then 
you can record that control. 

6. Where is my data? All automation is recorded into the currently selected pattern. To see it, 
in context, place the Pattern Clip in the track area, the display will show a mini-graph. 

 
 

 
 

Song Mode plays from Playlist Record Switch 

Red Dots Hint bar: 
Description 

Plugins.  You can record live tweaking (moving) of knobs 
on most Plugins, but not all knobs. Experiment to find out. 
Check the live manual (press F1 in FL Studio) section on 
Recording Audio, Notes & Automation. 

Intro count in 
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LemonBoy's Live Tweaking Recording AdviceK 
 

1. Always, always, always check the pattern selector before you start 
recording. Automation will be recorded into the selected pattern. 
 
2. Right-click on the record button to check Automation, Score (notes) 
and or Audio is ticked. Depending on what you want to record. 
 
3. Get your song laid out the way you want it before you start live 
recording.  This makes it much easier than trying to align automation to 
song structure. It’s better to record automation on an existing song. 
 
4. Always save a backup copy of your project before you start any live 
recording.  That way if you mess things up or change your mind, you can 
go back to the clean copy. 
 
5. Save your project frequently during live recording. Press Ctrl+N to quick-
save a ‘new’ copy of your project.  This adds a _1, _2, _3 etc each time you 
do it to your project file. If you accidentally tweak something and erase 
some events, you can always go back to any previous version.  
 
6. Get yourself an External Hardware controller to make your life easier 
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TTTTTTTTHHHHHHHHEEEEEEEE        EEEEEEEEVVVVVVVVEEEEEEEENNNNNNNNTTTTTTTT        EEEEEEEEDDDDDDDDIIIIIIIITTTTTTTTOOOOOOOORRRRRRRR        ((((((((EEEEEEEEddddddddiiiiiiiitttttttt        AAAAAAAAuuuuuuuuttttttttoooooooommmmmmmmaaaaaaaattttttttiiiiiiiioooooooonnnnnnnn))))))))        
Unless you're a real pro, you'll probably find that the live automation doesn’t always sound  
perfect.  That's where the event editor comes in.  Each time you move a knob during a recording 
session, the new setting is stored as an "event" for that knob at that moment in the loop.  With the 
event editor, you have complete control over how the sound is tweaked during playback. NOTE:  
You will find an option under the Edit Menu to convert Event data to Automation Clips. This 
allows you to export the automation to a format that can be directly tweaked in the Playlist rather 
than in the editor. 
 
1. Record Some Live Tweaking on a Particular Knob.  The PAN on the Snare sample, for 

instance.  Let's assume you already did that in the previous section.   
 
2. Stop FL Studio and Open the Event Editor.  Right-click on the knob you automated, and 

select Edit Events from the pop-up menu.  The screen you are looking at now is a lot like 
the Graph Editor described earlier.  One difference is that this graph controls the level of a 
single knob or slider at a particular point in the song.  (OK, it's actually more complicated 
than that.  Remember how we told you to keep all your live recording in a single pattern 
(Pattern 2) and place this pattern once at the beginning of a song?  If you do that, then the 
bars in the Event Editor will match the bars in the Playlist.  If you don't do that, you're on 
your own!) The other main difference is that this graph is used to set Events (bright vertical 
lines corresponding to the value of the knob you are setting) that persist until the next event.  

 
 
 
 

 
 
 
 
 

Edit mode selection Edit menu 

Play position 
indicator 

Automation data (events).    
 

Vertical zoom  
(click + drag)  

Select automation  
 

Horizontal zoom  
(click + drag)  
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3. Event Editor Modes. The event editor has several modes, which are explained below. 
 

a. Draw Mode.  In this mode, the mouse pointer looks like a pencil .  You can add new 

single events by left clicking in the main window.  You can also left-click and drag to 
draw multiple events, or right-click and drag to draw a line of events. 
 

b. Brush Mode.  This mode ( ) is very similar to Draw mode, but ignores snap distance 

the mouse. 
 

c. Delete Mode.  Click on the delete symbol  to change to this mode.  You can delete 

events by clicking on them, or click and drag to delete a series of events (the events are 
the bright vertical lines on the main window.) 

 

d. Smooth Mode.  Click on the smoothing (interpolation) symbol  to change to this 

mode. You can click and drag to highlight a region. When you let go of the mouse button, 
the events will be smoothed out, instead of looking choppy. Try it! You can also turn on 
Auto-Smoothing from the edit menu, so that events you draw in Draw Mode are 
automatically smoothed out. 

 

e. Select Mode.  Click on the select symbol  to change to this mode.  When you click 

and drag, you will see a red region highlighted on the Play Indicator Bar. You can also 
right-click on the Play Indicator Bar in any mode to expand the highlighted region. You 
can cut and zoom to this region from the Edit Menu. 

 

f. Zoom Mode. The zoom mode -  allows you to select an area in the event editor an 

automatically zoom fit to that area. 
 

4. Miscellaneous Facts.  Here's some stuff you should know about the Event Editor. 
 

a. Undo. There is a limited form of undo available for the Event Editor.  Use CTRL-Z to 
undo the last action. 

 

b. Setting the Initial Event. You will notice that after live recording, the knob you 
recorded sometimes doesn't start in a sensible place when you play back the loop.  This 
can be fixed by turning the knob to a good start position, and then right clicking the knob 
and selecting Init Events With This Position. This sets the very first event so that the 
knob will always start where you want it. 

 

c. Getting a Feel for It. It takes some practice to master the event editor, and to be able to 
get a song to sound exactly the way you want it, but it's definitely worth it.  Keep 
practicing until you get it right! 

 

d. Live Recording Defeats Static Tweaking.  If a knob has some events recorded on it, 
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you can no longer just set it anywhere you want and expect it to stay there.  You have to 
go through the Event Editor or start a new live recording session to change it. 

 
5. Introducing the Event LFO. Sometimes you want basic oscillation of a parameter, but it’s 

hard to control exactly how this oscillation is going to fit with the song.  That problem is 
solved with the Event LFO, which lets you simulate the perfect oscillation inside the event 
editor and align the peaks/troughs against the tempo grid.   

 

 
 
 

6. Using the Event LFO. Open . the event editor for some control.  Make sure you're on the 
right pattern in the pattern selector.  Now select an area to oscillate using Select Mode or by 
right-clicking on the Play Indicator Bar.  Now hit ctrl-l or select LFO from the Tools Menu.  
This will pop up the LFO Settings window and immediately apply the LFO to the selected 
area.  See above. 

 
7. Play with the Main LFO Settings.  Notice the dialog has three sections.  If you play with 

the controls in the Start and Shape sections, you should be able to create all kinds of cool 
effects.  In the Start section, you can alter the value (height), range (depth), and speed 
(length) of the waves.  In the Shape section you can alter the shape of the wave (sine wave, 
saw-tooth, or square) and the phase (basically moves the waves left and right.)  
 
 
 
 
 

+ me; me; me; ∗ 

∗ me; me; me; +  

∗ meeee;me! 
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8. What About the End Section?  If you want to make the LFO change as it progresses, turn 
on the End section by pressing the red button.  Once the light is on, you can modify the 
parameters for the beginning (left) and end (right) of the LFO, and FL Studio will smoothly 
morph the settings from start to end.  This lets you create really cool changing LFO effects 
like below.  In the picture, a square wave LFO starts at bar 2 and ends at bar 4.  As the LFO 
progresses, the speed increases and the value and range decrease from their Start to their End 
values. 

 
 

                         
 

 

 

 

 

 

 

 

 

 

 

horizontal position 

My brilliant adlib performance!  FL Studio 
has a 3 minute rolling recorder that captures 
all keyboard performances. It’s always on, 
so never lose that amazing adlib. Check out 
the Tools > Dump score log to selected 
pattern feature! 
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9. What is in the Edit Menu?  In the Edit Menu you can delete all events (Edit > Delete All), 
select all events (Edit > Select All), and change the color and look of the editor (Settings). 
One of the most useful commands there is the Edit > Turn into Automation Clip 
commands. As mentioned earlier, this turns the Event automation into an Automation 
Clip. The conversion process may change things slightly, but you can then add the 
Automation Clip to the Playlist and drag the control points on the line around to edit them. 
Very cool! To learn more about Automation Clips see page 69. 

  

10. The Snap menu ( )  is also important. Snapping automatically aligns things you are 

moving around in the Event Editor, for example, so placement is always right on a beat or 
bar.  The Snap resolution can be also changed on the main toolbar, however the local Snap 
overrides the Global snap (shown below).  Try the different settings to see how it effects 
highlighting and event placement. The finest grain is Off, which will cause you to snap to 
extremely fine-grained locations between notes.  Note that there are also local snap settings 
for the Event Editor, Playlist  and Piano Roll so you can have different values in each 
place.  

 
 

 
 
 

 

 

 

 

 

 

 
 
 
 
 
 

        

        

        

        
 

        

Time for some ‘snappy’ tipsK*groan* 
  

* The SNAP shown above is the ‘global’ snap, there is a local snap 
for the Event Editor, Piano Roll and the Play List so these may be 
set independently. 
  
* You can undo an LFO with Ctrl-Z. 

Global snap 
resolution. 
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        AAAAAAAAUUUUUUUUDDDDDDDDIIIIIIIIOOOOOOOO        RRRRRRRREEEEEEEECCCCCCCCOOOOOOOORRRRRRRRDDDDDDDDIIIIIIIINNNNNNNNGGGGGGGG                
 
What about Audio recording? You will need FL Studio Producer edition or higher plus use an 
ASIO soundcard driver selected from the Audio Options (Press F10 on your keyboard to open 
them). It’s a huge (but rewarding) area that is carefully covered in the on-line manual. Press F1 in 
FL Studio and click on the Contents section ‘Recording Audio, Notes & Automation’, then the 
‘Audio Recording’ page.   However we will tell you now that external audio inputs come into FL 
Studio through the Mixer IN menus. There is one on each track, so get that sorted and you are on 
your way! 
 
 

        
 

 

  External audio inputs are selected from the FL Studio 
mixer INPUT menu. The 'IN' menu shows a drop-down list 
of the available soundcard inputs (mic, line etc). The 
screenshot above shows (none) as no input is selected 
yet (each mixer track has it's own external input options 
menu). Input options will only be visible if an ASIO 
soundcard driver is active. Note: The input names shown 
in the drop-down menu are provided by the soundcard 
driver and are often given strange names, so 
experimentation may be required to find the correct input. 
Time to go buy some MICROPHONES!!!!!!  
 



 

 70 

EEEEEEEEDDDDDDDDIIIIIIIISSSSSSSSOOOOOOOONNNNNNNN        WWWWWWWWAAAAAAAAVVVVVVVVEEEEEEEE        EEEEEEEEDDDDDDDDIIIIIIIITTTTTTTTOOOOOOOORRRRRRRR        ////////        RRRRRRRREEEEEEEECCCCCCCCOOOOOOOORRRRRRRRDDDDDDDDEEEEEEEERRRRRRRR                        
 

IMPORTANT: This guide is a general Getting Started guide for all existing FL Studio Editions. 

Some features however, are not available in some editions. The FL Studio Fruity Edition doesn’t 

have Audio Track or the Integrated Wave Editor capabilities. Please check our site 

http://flstudio.image-line.com  for upgrade conditions. 
 
Edison is a fully integrated audio editor and Mixer-track recorder. Edison loads into an effect slot 
(in any Mixer track) and will then record or play audio from that position. You may load as many 
instances of Edison as you require in any number of Mixer Tracks or Effects slots. To open 
Edison, press Ctrl+E in a Sampler Channel, or load from the effects menu into Mixer track/s.  
 
Many powerful tool are available within Edison. Brief descriptions of some tools, and how to 
open them are provided below. 
 

 
 

The Edison Amp Tool works in a similar way to the Mixer track controls, including stereo 
separation, panning, linked and independent L and R Channel volume. To open the tool, press 
Alt+A inside Edison, or use the Tools>Amp>Amp option. 

 

The Convolution Reverb engine in Edison works by multiplying two audio signals in the 
frequency domain as a sort of 'moving average'. A reverb effect is obtained when an 'impulse' file 
is convolved with the original wave file. Reverb impulse files are created by recording short, 
sharp sounds in real spaces or through a reverb/effects unit. The recorded sound is then an 
acoustic fingerprint of the reverberant space. This technique is equivalent to sampling an 
instrument and is very powerful, allowing you to 'borrow' impulses from very expensive 
hardware or real spaces you would never have the chance to record in. A convolution reverb will 
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sound identical to the original space or hardware (with the particular settings used). Of course, the 
internet is brimming with free impulses for your downloading pleasure (see 'Impulse Resources' 
below).  

To open the dialog you can either left-click on the Convolution Reverb button , press Ctrl+R 
inside Edison, or use the Tools > Spectral > Convolution Reverb option. Once an impulse is 
loaded you can perform any of Edison's editing functions in the spectral preview window. Right-
click on the spectral preview to open the editing options. 

 
 

The Edison Blur Tool works in a similar way to the Convolution Reverb, by multiplying an 
impulse sound (in this case, noise), against the waveform. The impulse function is cross-
multiplied with the source in a moving average, to smear or 'blur' the sound. The multiplier 
function is determined by a user-selectable envelope. To preserve more of the original qualities of 
the sound, use narrower shaped envelopes. 
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The Equalize Tool boosts or cuts frequencies according to a user defined EQ envelope. The 
example below shows the effect of the selected EQ curve on a white noise sample. Frequency is 
displayed on the horizontal axis, time on the vertical axis (sample start is at the top, sample end is 
at the bottom) while intensity/saturation of color represents frequency amplitude.  

To open the tool you can either left-click on the EQ Tool button  , press Ctrl+E inside Edison, 
or use the Tools > Spectral > EQ option. 
 

 

 

The Time Stretch / Pitch Shift tool allows you to alter the duration, pitch and formant of a 
sample independently. Edison and, more generally the Sampler Channels & Slicer tool, use the 
élastique Pro, zplane algorithms to deliver advanced time stretching / pitch shifting that meets the 
standards of professional production and broadcast applications.  

To open the tool you can either left-click on the Time Tool button , press Alt+T inside 
Edison, or use the Tools > Time > Time stretch / Pitch shift option. To open the paste-stretch 
dialog press Ctrl+Alt+V or use the Tools > Edit > Paste stretch option. The paste-stretch dialog is 
available only after a sample selection cut or copy operation. 

The Edison Loop Tuner allows you to remove clicks, pops or beating sounds from a loop. The 
Loop Tuner is not an automatic loop finding tool, it is intended for smoothing loops that have 
already been selected. Be aware that to accommodate the loop smoothing process, some settings 
will move the loop-start point automatically. To preserve your loop-start point, set the Crossfade 
and Snap settings to minimum. 
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Beat slicing. Edison has a range of beat slicing and drum stretch tools (Tools > Time > 
Drum(loop) stretch) that will allow you to create your own sliced beats.  
 
 

 

        

        

        

        

        

        
 

Cool! Hit me with your rhythm stick!  I live for beats. 
Fast beats, slow beats, big beats;  
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SSSSSSSSHHHHHHHHAAAAAAAARRRRRRRRIIIIIIIINNNNNNNNGGGGGGGG        YYYYYYYYOOOOOOOOUUUUUUUURRRRRRRR        WWWWWWWWOOOOOOOORRRRRRRRKKKKKKKK        
So now you’re done with your song – you probably want to get it out of FL Studio so you can put 
it on a CD, post it on the Internet, or edit it in another program. The Export function exists for 
this purpose. Here's how to use it. 
 
1. Export to Wav,  Ogg.  or MP3. This option is available from the Main File menu. Whether 

you choose Wav, Ogg or MP3, you will be asked to specify the name of the file and then the 
dialog below will appear.  There's a lot to choose from here, and we don’t have space to go 
into detail.  If you want an explanation of every button, go to the on-line help F1, it's all there. 
...    

 

 
 

2. Should I Use Wav, Ogg or Mp3?  Wav is a raw sound file format.  Huge files, excellent 
sound quality (expect to use about 10 MB per minute depending on Bit Depth).  44.1 kHz, 16 
bit Wav files are for burning onto CD.  MP3/Ogg are compressed formats with smaller 
files, but sound quality may be compromised (expect to use about 1 MB per minute 
depending on Bit Rate).  If you want to share files on the Internet, MP3/Ogg are perfect. 

Are you in SONG 
mode?  
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3. Should I Use "Background Rendering?"  Rendering can take a long time and hogs the 
CPU, especially if you choose the higher-quality options in the Quality section of the 
window above.  But if you click on Background Rendering, FL Studio will minimize and 
continue to render unobtrusively in the background.  It takes longer…but the internet has 
plenty to see while you wait. 

4. Exporting to a Zipped Loop Package.  This feature is useful if you want to transmit your 
FL Studio project over the web. It takes your FL Studio file, plus all the samples used in that 
files, and puts them into one zip file.  Note that it does not save the plugin Instruments you 
used, just the samples. 

5. Project Bones and Project Data Files. These options let you save a lot of the information 
about your track. The Project Bones option saves a file with all your presets, automation 
information, and so on to be loaded later. Project Data Files saves all the samples and other 
raw data you used to a single location on your hard drive. 

6. Where Can I Put My Songs? There are a number of places on the web where artists can 
place their music in MP3 format for free.  http://www.mp3.com is probably the best-known 
site, but it's easy for an amateur looper to get buried there in all the high-profile commercial 
stuff.  Image-Line (that’s us) has a Song Exchange forum (http://forum.image-
line.com/index.php) if you are more interested in feedback from other musicians who use FL 
Studio. It's a great way to get feedback from fellow Floopers (that’s you).  If you don't like 
either of these options, you can always create your own site using one of the many free 
hosting services out there.  Did you know we also make our own website building tool? It’s 
called EZGenerator, check it out here - www.ezgenerator.com Too EZ! 

 
 
 
 
 
 
 
 
 
 

        
 
 

        

If you want to share your work to the big public, 
consider setting up your own website! 
 
Try EZGenerator Web Site Builder  (read easy 
generator), the tool we use to setup and 
maintain our own websites  
 
This is another piece of high quality software 
developed by Image Line Software!  
 
Free Trial version at: 
http://www.ezgenerator.com 
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EEEEEEEEXXXXXXXXTTTTTTTTEEEEEEEERRRRRRRRNNNNNNNNAAAAAAAALLLLLLLL        CCCCCCCCOOOOOOOONNNNNNNNTTTTTTTTRRRRRRRROOOOOOOOLLLLLLLLLLLLLLLLEEEEEEEERRRRRRRRSSSSSSSS        
 

Did you know that you already have at least two ‘external controllers’ attached to your PC? One 
is your typing-keyboard and the other is your mouse.  Obviously these don’t make sounds, but 
send control signals to your PC so you can type and move your mouse. Similarly, external 
USB/MIDI controllers are just devices to send control signals to your PC, however in this case 
they are designed to play like a piano keyboard, move like a Mixer desk, turntable deck or any 
other piece of hardware that is used to make/mix music. With a controller attached you can move 
the  knobs and switches in FL Studio, or play a plugin instrument like a synthesizer. The only 
catch is that as the controller isn’t hard-wired to particular functions, you have to tell FL Studio 
ahead of time what you want each knob on the controller to do (this is just the same as assigning 
your typing-keyboard control-keys in a game for example, a minor inconvenience for the luxury 
of changing both cutoff and resonance at the same time!)  Each knob on the controller can be 
linked to a different knob or slider on FL Studio.  If you have a controller, this section will tell 
you how to make it work with FL Studio.  If you don't have one, get one, if you aren’t sure where 
to start consider a small 2 octave MIDI keyboard with some knobs, you won’t regret it!  First 
we'll introduce a few of the more popular controllers, and then we'll tell you how to set them up. 
 
1. A Few Examples of Controllers.     

 
Korg NANOKEY & NANOKONTROL – These are tiny-tiny controllers (with a tiny price 
to match), great for people on the move with a laptop. The one with the knobs has 9 
assignable knobs and 9 sliders that can be linked to knobs and sliders in FL, has transport 
controls to start/stop FL Studio and is connected to your PC over USB. Easy! There are a 
range of small MIDI keyboard controllers out there, time to hit Google and check them out! 
 

 
 

 Nanites? Aren’t they dangerous!? Watch out for 
replicators man!!!! 
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Behringer B-Control.  Alternatively the B-Control has larger knobs and sliders. Again this is 
connected to your PC by USB. Too easy! 
  

 
 

Other Controllers.  -  If you are serious then the sky is the limit, the Keystation Pro-88 has 
more control action than you are ever likely to need. Similarly if you already have other 
MIDI hardware, like the AKAI MPC (shown below) then that can be used to control FL 
Studio too (the MPC is the perfect match for our FPC plugin!).  
 

 
 

  
 
 
 
 
 
 
 

Whoa! Talk about 
bringing a gun to a 
knife fight! Are you 
sure this thing can’t 
make any sounds of 
its own?  

Legendary AKAI MPC + FPC  = Bliss ☺☺☺☺ 
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2. Setting Up Your Controller.    
 

a. Connect your controller to your PC (USB or MIDI).  These days most MIDI 
controllers use a USB cable, but if you have older MIDI equipment it will have MIDI 
specific cables (large round 5 pin connectors). You will need to buy a MIDI to USB 
interface for your PC. Note: MIDI is not an audio connection - MIDI connections transfer 
note data, knob movements and program changes so that your controller can play 
software instruments and or FL Studio can play connected MIDI hardware. To use 
sounds from an external synthesizer (while it is played by FL Studio) you will need to 
make MIDI connections (discussed here) AND audio connections to your soundcard 
inputs so that FL Studio can record the sound/s that it triggers from the external MIDI 
hardware using a MIDI Out. Check the FL Studio manual (F1 key) for more details. 

b. Turn on the Controller (wait for it to be detected by Windows) and THEN Start Up 
FL Studio. Press F10 to open the system settings. Just select ‘Generic Controller’ in the 
controller type for now, although if your controller shows then definitely select that.  Try 
turning the knobs on your controller.  If everything is ok, you should see a little red 
"Midi" light flash beside the Hint Bar of FL Studio every time you turn a knob or hit a 
key.  If that works, great!  You can skip steps c to e.  If not, read on my friend. 

 

1. Click here 

3. Then here & 
Select generic. 
 

2. Then here 
 
 
4. And here 
 
5. Then here 
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c. Check the Options menu to see if there is a check mark beside Enable MIDI Remote 
Control. If not, click on it and see if you get the light now.  If not, read on. 

 
 
 

 
           FLooper 

 
 

d. Set Your MIDI Input Device.  If the light is still not coming on when you turn knobs on 
your controller, go into MIDI Settings (from the Options menu or by hitting F10).  
Check out the Remote Control Input box.  If you see the word "none" there, then you've 
got to select an input.  Typically, you will be presented with a number of choices, and 
you'll just have to try them all to figure out which one is right. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

FLooper: Yo, check it out. I need a keyboard 
controller for FL Studio.   
 
Computer Store Guy:  QWERTY or AZERTY? 

The little 
red light 

Hey did you know you can use MORE than one 
controller with FL Studio at the same time? Just 
set each of your controllers to transmit on a 
separate MIDI Channel (check the manuals that 
come with your gear) and you can control 
multiple Instrument Channels or the Playlist 
jump-to markers;COOL! 
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e. Troubleshooting Checklist.  If the red light is still not coming on when you turn the 
knobs on your controller, here's a list of things you should check. 

 
* Did you select the correct controller type in step b? 
* Did you enable "Enable MIDI Remote Control" in step c? 
* Did you select the correct MIDI input in step d? 
* Is your USB controller detected OR are your MIDI In and Out cables reversed? 
* Did you plug the controller into a power outlet? 

 
The fun part - Linking a knob to Your Controller:   
 

a. Right-click on the Control You Want to Link to the hardware controller.  In this 
case, we're trying the main volume control on a sampler Channel.  Now right-click on 
the knob and select Link to controller, to pop up the Remote controlling settings 
window. 

 
 

 
 
 
 
 

b. Turn a Knob on Your Controller.  You should see the Remote controlling settings 
window disappear and the Channel Volume knob should now move in response to your 
hardware knob movements.  You're in business! 

 
c. Set the Buffer Length as Low as You Can.  Earlier, we explained the buffer length 

slider (get to it by hitting F10 and clicking the Audio tab).  This slider determines the 
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delay time between you turning a knob and the sound of FL Studio changing.  So you 
want to set it low.  But if you set it too low, the sound will become choppy.  So try to find 
a happy medium.  If you can't get it low enough to do what you want, then I guess you 
need a faster computer. Sorry, dude. 

 
3. Which Controls Can I Link? Pretty much all of them, actually.  For reference, though, it's 

the same set of controls that can be changed in Live Recording.  Again, if you want to know 
whether a control can be linked externally and live recorded, mouse over it and look for the 
two red dots in the Hint Bar.   

 

4. What About Internal Controllers? Finally, we can tell you about the Internal Controller 
Plugins listed in the Effects section (the Formula Controller, Peak Controller, and X-Y 
Controller). These are plugins with controllers, which can set other controls. Did you follow 
that? Let’s take the Fruity X-Y Controller as an example. Open the Mixer window (F9) and 
put a Fruity X-Y Controller on the master Mixer track. 

 
 

 
 

 

a. The Fruity X-Y Controller lets you control two knobs at once by linking one knob to its 
X (horizontal) dimension and one knob to its Y (vertical) dimension. Then you can grab 
the circle in the main window and as you pull it around, it changes both controls that it is 
linked to.  It’s particularly handy for controlling cutoff and resonance at the same time. 
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b. Link the Cutoff knob to the X value of the internal controller, as shown above. Now link 
the Resonance knob to the Y value. Then open up the Fruity X-Y Controller window, 
start the loop, and drag the circle around to listen to the Cutoff and Resonance changing 
at the same time. Cool, huh?  

 

 

        
 
 

Well, that’s it. Have fun! Don’t forget 
there’s more help available inside 
FLStudio (F1) and on line at 
http://flstudio.image-line.com. 
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A big round of applause for the 
FLStudio teamKbut wait until I 
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record it into FL Studio! 
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Main window, 10 
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Phase inversion, 59 
Phaser, 53, 59 
Piano roll, 24, 25, 27, 28 

Editing, 26 
lower panel, 25 

Ping pong delay, 17 

Pitch, 17, 18, 20, 22, 28, 51 
Piano roll, 24 

Pitch bend (slide), 21, 28 
Pitch bending, 27 

Play indicator, 24, 29, 65 
Play switch, 10, 12 
Playlist, 29, 30, 61 
Plucked!, 33, 34, 44 
Plugin, 14, 33, 49, 50, 54, 55, 56, 59, 60 
Plugin instruments, 35 
Plugin Order, 56 

PoiZone, 43 
Polling, 8 
Presets, 34, 60 
Project bones, 75 
Project data files, 75 

R 

Recording 

automation, 65 
Release (REL), 18 
Remote control input, 79 
resonance & cutoff, 57 
Resonance & cutoff, 17, 18, 20, 21, 22, 57, 64, 76, 
81 

Reverb, 53, 55, 59 
Room sound, 59 

S 

Sample browser, 14, 15, 51 
Sample editor, 70 
Sample slicer, 42 
Sampler, 16 
samples, 14, 40 
Samples, 14, 15, 18, 19, 22, 23, 33, 34, 43, 51, 
55, 57, 59 

Save 

16bit, 74 
24bit, 74 
32bit, 74 

Save audio, 74 

Save samples, 75 
Sawer, 44 
Send tracks, 55 
Send Tracks, 55 
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Serial Number, 6 

Setup Wizard, 11 

Shift, 20, 22 
Shortcuts, 10 
SimSynth 

Live, 33, 34, 44, 50 
Slicex, 45 
Slide (pitch bend), 21, 28 
Snap 

Global, 68 
Snap to grid, 26 
Song/pat, 29 
Soundcard Driver, 7 
SoundFonts, 33, 34, 43 
Spectrum analyzer, 36, 59 
Speech Synthesizer, 51 
Speed (SPD), 18 
Step, 13 
Step sequencer, 14, 23, 24, 28, 29, 34, 51 
Steps, 12, 20, 21, 22, 24, 29, 62 
Stereo shaper, 59 
Sustain (SUS), 18 
Synth channels, 50 
SynthMaker, 45 

T 

TB-303, 46 
Technical support, 6 
Tick, 62 
Tool bar, 29, 68 
Toxic Biohazard, 42 
Transport Panel, 13 

Troubleshooting, 80 
TS-404, 33, 34, 46, 62 
Ttool bar, 26 
Tutorials, 10, 58 

U 

Undo, 27 
Event editor, 65 
Piano roll, 27 

V 

Velocity (volume), 20, 21, 28 
volume, 18 
Volume, 13, 18, 20, 21, 53, 57, 80 
VST plugin, 49, 50 
VST Plugin, 48 

W 

Wasp, 33, 34, 47 
Wav 

export to wav, 74 
Wave editor, 70 
Windows, 8 

Z 

Zipped loop packages, 75 
Zipped project, 75 
zoom, 25 

Zoom, 64 

 
 
 
 
 


